IMPORTANT!

You need to reinstall EPSON® Image Authentication System™ (IAS) on your camera if it was installed before your camera was repaired. Please see your EPSON Image Authentication System User’s Guide for instructions.

IAS software lets you check the authenticity of photos taken with your EPSON Photo PC® 700, 750Z, 800, or 850Z camera. IAS detects when even a single bit of digital data in a picture has been altered. If you don’t have IAS installed on your camera and would like to learn more about it, call 1-800-GO EPSON, or visit our website at http://www.epson.com.
User’s Guide
FCC COMPLIANCE STATEMENT
FOR AMERICAN USERS
This equipment has been tested and found to comply with the limits for a
class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio and television reception.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the
following measures:
◗ Reorient or relocate the receiving antenna
◗ Increase the separation between the equipment and receiver
◗ Connect the equipment into an outlet on a circuit different from that to
  which the receiver is connected
◗ Consult an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment
will invalidate the FCC Certification of this device and may cause interference
levels that exceed the limits established by the FCC for this equipment. It is the
responsibility of the user to obtain and use a shielded equipment interface cable
with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces.
Changes or modifications not expressly approved by the manufacturer could
void the user’s authority to operate the equipment.

FOR CANADIAN USERS
This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du
Canada.
IMPORTANT NOTICE
DISCLAIMER OF WARRANTY
Epson America makes no representations or warranties, either express or implied, by or with respect to anything in this manual, and shall not be liable for any implied warranties of merchantability and fitness for a particular purpose or for any indirect, special, or consequential damages. Some states do not allow the exclusion of incidental or consequential damages, so this exclusion may not apply to you.

COPYRIGHT NOTICE
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Epson America, Inc. No patent liability is assumed with respect to the use of information contained herein. Nor is any liability assumed for damages resulting from the use of the information contained herein. Further, this publication and features described herein are subject to change without notice.

TRADEMARKS
EPSON and EPSON Stylus are registered trademarks of SEIKO EPSON CORPORATION.
PhotoPC is a registered trademark and EPSON FaxAdvice, EPSON Photo'2, HyPict, and Solar Assist are trademarks of Epson America, Inc.
EPSON SoundAdvice is a service mark of Epson America, Inc.
Image Expert and Camio are trademarks of Sierra Imaging, Inc. in the United States and other countries and are used under license.
Lexar Media is a trademark of Lexar Media.

General notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

A NOTE CONCERNING RESPONSIBLE USE OF COPYRIGHTED MATERIALS
Digital cameras and scanners, like photocopiers and conventional cameras, can be misused by improper copying of copyrighted material. While some countries’ laws permit limited copying in certain circumstances, those circumstances may not be as broad as some people assume. EPSON encourages each user to be responsible and respectful of the copyright laws when using digital cameras and scanners.
Contents

Introduction
PhotoPC 750Z Features 2
Optional Accessories 3
Minimum System Requirements 4
Windows Systems 4
Macintosh Systems 4
Where To Get Help 4
Software Support 6
Software Licensing 6
Registration 6
Safety Instructions 6

1 Using Advanced Camera Features
Taking Pictures With the Timer 1-2
Using Macro Mode to Take Close-ups 1-2
Taking Digital Panoramic Pictures 1-3
Taking Digital Zoom Pictures 1-5
Using the View Mode Menus 1-5
Continuous Shooting 1-7
Automatic Continuous Shooting 1-8
Taking Quick Shots 1-9
Taking HyPict Mode Pictures 1-10
Using Advanced Settings 1-11
Using White Balance 1-11
Photographing With Fixed White Balance 1-12
Photographing With User Defined White Balance 1-13
Adjusting Exposure 1-14
Adjusting Sensitivity for Night or Indoor Photos 1-16
Using Slow Synchronized Flash Mode for Night Photography 1-17

2 Playing Back Photos
Using the Playback Mode 2-2
Playing Back Pictures One by One 2-3
Playing Back Multiple Pictures 2-4
Playing Your Pictures as a Slide Show 2-5
Turning Off Picture Information 2-5
Magnifying a Picture 2-6
Erasing Pictures 2-7
   Erasing the Currently Displayed Picture 2-7
   Selecting Pictures to Erase 2-8
   Locking Photos 2-9
   Unlocking Photos 2-11
   Playing Back Pictures on TV 2-12

3 Getting Photos Into Applications and Documents
   Getting Images Into TWAIN Applications 3-1
   Getting Images That You Can Import 3-3
      What To Do If the Camera Is Not Responding 3-5
   Importing Images Into Documents 3-6
   Getting Images With Copy and Paste 3-8
   Using Drag and Drop From an Album (Windows Only) 3-8
   Getting Images With the Camio Viewer (Windows 95, Windows 98, and Windows NT 4.0) 3-10
   Dragging and Dropping a Picture Into a Document 3-11
   Transferring Images Before Placing Them 3-12

4 Working With Photos and Albums
   Using Albums 4-2
      Organizing Pictures in Albums 4-2
      Renaming a Picture 4-3
      Viewing Picture Information 4-3
   Printing an Image or Album 4-4
      Choosing the Layout Style 4-5
      Adding Text 4-7
      Choosing Album Images 4-8
      Adjusting the Printed Area 4-8
   Adding Sound to an Image 4-9
      Playing Back Sounds 4-10
      Editing Sounds 4-11
      Deleting Sounds 4-11
   Adding Annotations 4-12
      Blending In Annotations 4-13
      Deleting Annotations 4-13
   Displaying Albums as Slide Shows 4-14
   Using an Album as a Screen Saver 4-15
   Setting an Image as Wallpaper 4-15
   Copying to Diskette or Zip Disk 4-16
      Viewing the Pictures on Diskette or Zip Disk 4-17
   Sending Pictures and Sound by E-mail 4-18
5 Editing Images
- Viewing and Selecting Images 5-2
- Applying Quick Fix 5-3
- Correcting an Image 5-3
- Cropping an Image 5-5
- Resizing an Image 5-5
- Rotating an Image 5-6
- Flipping an Image 5-7
- Applying Special Effects 5-7
- Creating Panoramas 5-8
  - Picture-Taking Tips 5-9
  - Stitching Images 5-9
  - Troubleshooting Panoramas 5-10
- Changing the Number of Colors 5-12

6 Using Custom and Advanced Features
- Taking Pictures From Your Computer With Image Expert 6-1
- Using the Self Timer 6-3
- Setting the Shutter Speed 6-4
- Taking Pictures With EPSON Photo!2 6-4
- Adjusting Camera Settings From Your Computer 6-6
  - Changing Settings With Image Expert 6-6
  - Changing Settings With EPSON Photo!2 6-8

7 Using Your Camera for Presentations
- Uploading Images to the Camera 7-1
- Uploading Existing Images From Your Windows PC 7-2
- Uploading Images From Your Macintosh 7-5
- Converting Presentations 7-7
- Capturing Windows Screens 7-8
- Capturing Macintosh Screens 7-9
- Projecting Your Presentation 7-10

8 Using CompactFlash Memory Cards
- Installing a Memory Card 8-2
- Formatting a Memory Card 8-3
- Removing a Memory Card 8-4
- Getting Images From a Card to Your Computer 8-4
  - Using a PCMCIA Adapter 8-5
  - Transferring Photos 8-5
- Getting Memory Information 8-6

Customizing Settings With the LCD Screen 6-9
- Setting the Camera Clock 6-10
- Setting the Alert Beep 6-11
- Setting the LCD Brightness 6-11
- Setting the Power Mode 6-12
- Setting the Language 6-12
Copying To and From a Memory Card 8-7

9 Printing Directly From the Camera

Uploading Direct Print 9-2
Connecting the Camera to the Printer 9-4
Starting Direct Print 9-5
Printing 9-6
  Printing a Full Size or 5 × 7 Image 9-6
  Producing Your Printout 9-11
  Printing a Card 9-11
  Printing Album Images 9-13
  Printing Stickers 9-14
  Printing a Contact Sheet 9-16
Cleaning the Print Heads 9-17
Removing Direct Print 9-18
Reading Error Messages 9-18

10 Maintenance and Troubleshooting

Caring for the Camera and Battery Charger 10-1
Cleaning the Camera and Battery Charger 10-1
Storing the Camera 10-2
Solving Camera Problems 10-2
Solving Picture Problems 10-8

A Optional Accessories

Using the Optional AC Adapter A-2
Using an Optional Tripod A-2
About the IOMEGA Clik! Drive A-3

B Specifications

Camera B-1
  Physical Dimensions B-1
  Safety Specifications B-1
  Power B-1
  Technical B-2
  Environmental B-2
  Photographic B-3
  Camera Picture Capacity B-4
NiMH Battery Charger B-4
  Physical Dimensions B-4
  Technical B-4
Optional AC Adapter B-5
  Physical Dimensions B-5
  Technical B-5
Your new EPSON® PhotoPC® 750Z is a high resolution, easy-to-use digital camera with a built-in LCD screen and 3× optical zoom. You can view your pictures before and after you capture them, or display them on a TV or multimedia projector and transfer them to your computer. You can even upload pictures, text, and graphics into your camera, and play them back for presentations.

PhotoPC 750Z captures images at 1280 × 960 pixel resolution in 24-bit color, using a 1.25 megapixel CCD sensor. With Epson’s HyPict™ image enhancement technology, the images can be interpolated to 1600 × 1200 pixels right inside the camera. The PhotoPC 750Z comes with 12MB of memory to store approximately 178 standard resolution images. The Solar Assist™ panel illuminates the LCD monitor in direct sunlight, saving battery life.
Your PhotoPC 750Z comes complete with cables, batteries, battery charger, camera bag, software, and utilities for downloading, editing, organizing, and printing your pictures.

**PhotoPC 750Z Features**

PhotoPC 750Z is a complete system for capturing digital images, and includes the following features:

- Resolutions up to $1280 \times 960$ pixels, and up to $1600 \times 1200$ pixels (interpolated) using HyPict mode
- $3\times$ true optical zoom (34 mm to 102 mm)
- 4MB internal flash memory and an 8MB Lexar Media™ CompactFlash™ card that together hold approximately 54 fine-resolution or 178 standard-resolution images
- 24-bit color or grayscale image capture
- Two-inch, active matrix TFT color LCD screen with Solar Assist for previewing and playing back pictures
- Video output for playing your pictures back on a TV, VCR, or projector
- Macro, digital zoom, panorama, continuous and quick shot modes
- Automatic, preset, or user-defined white balance and adjustments for exposure and sensitivity
- Built-in flash with a slow synchronized mode for night photography
- Capability to print directly to several EPSON ink jet printers—without using a computer
- Automatic shut-off to save batteries
- Automatic date and time recording for each picture
- Cables for transferring photos to your Windows® PC or Macintosh® and displaying on a TV or multimedia projector
Your camera comes with the PhotoPC 750Z software suite, which includes the following applications:

- Sierra Imaging® Image Expert™ software for transferring, organizing, editing, and printing your pictures
- The EPSON Photo!2™ application and TWAIN driver for transferring and converting your pictures
- EPSON Photo File Uploader for converting presentation slides into image files and uploading them into your camera
- EPSON Photo Program Uploader for installing the Direct Print program on your camera; Direct Print lets you print directly from the camera to a number of EPSON ink jet printers.

Optional Accessories
EPSON offers these accessories for the PhotoPC 750Z:

- AC adapter for use with any standard (110 V) electrical outlet
- Replacement NiMH rechargeable batteries
- Replacement NiMH Power Pak including batteries and charger

You can also obtain additional CompactFlash memory cards and PCMCIA adapters available from leading suppliers, such as Lexar Media and SanDisk.® Also, you can purchase an IOMEGA® Clik! drive that lets you copy pictures directly from CompactFlash memory cards to your computer.
Minimum System Requirements

To transfer images to your computer and edit them, make sure your system meets these minimum requirements:

Windows Systems

- IBM®-compatible PC with 486 or higher processor
- Microsoft® Windows 98, Windows 95, Windows NT® 4.0 or Windows NT 3.51 (with Service Pack 3)
- Serial port with standard RS-232C interface (19,200 bps, or higher)
- At least 16MB RAM
- Double-speed CD-ROM drive
- At least 40MB free hard disk space
- VGA or SVGA monitor with at least 256-color display
- Mouse or other pointing device

Macintosh Systems

- Macintosh with PowerPC™ or higher processor
- System Software Version 7.1 or later (System 7.5 or later is required to access CompactFlash card memory directly from the Macintosh)
- At least 16MB RAM
- At least 40MB free hard disk space
- Double-speed CD-ROM drive
- VGA monitor with at least 256 colors
- Macintosh modem/printer serial port (19,200 bps, or higher)

Where To Get Help

EPSON provides technical assistance through electronic support services and automated telephone services 24 hours a day.
The following tables list the contact information:

**Electronic support services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach EPSON’s Home Page at <a href="http://www.epson.com">http://www.epson.com</a>.</td>
</tr>
<tr>
<td>EPSON Internet FTP Site</td>
<td>If you have Internet FTP capability, use your Web browser (or other software for FTP downloading) to log onto ftp.epson.com with the user name anonymous and your e-mail address as the password.</td>
</tr>
<tr>
<td>EPSON Forum on CompuServe®</td>
<td>Members of CompuServe can type GO EPSON at the menu prompt to reach the Epson America Forum. For a free introductory CompuServe membership, call (800) 848-8199 and ask for representative #529.</td>
</tr>
</tbody>
</table>

**Automated telephone services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON SoundAdvice™</td>
<td>For pre-recorded answers to commonly asked questions about EPSON products 24 hours a day, seven days a week, call (800) 922-8911.</td>
</tr>
<tr>
<td>EPSON FaxAdvice™</td>
<td>Access EPSON’s technical information library by calling (800) 922-8911. You must provide a return fax number to use this service.</td>
</tr>
<tr>
<td>EPSON Referral Service</td>
<td>For the location of your nearest Authorized EPSON Reseller call (800) 922-8911.</td>
</tr>
</tbody>
</table>

To speak to a technical support representative, dial (310) 974-1983 (U.S.), or (905) 709-3839 (Canada), 6 AM to 6 PM, Pacific Time, Monday through Friday. Toll or long distance charges may apply.

Before you call, please have the following information ready:

- Product name
- Product serial number
- Computer configuration
- Description of the problem

You can purchase manuals and accessories from EPSON Accessories at (800) 873-7766 (U.S. sales only). In Canada, please call (800) 873-7766 for dealer referral. Or visit our website at [www.epsonsupplies.com](http://www.epsonsupplies.com) (U.S. sales only).
Software Support
If you are having problems with a software application included with the camera, you can call one of the following numbers for technical support:

› (800) 501-8902 for Sierra Imaging Image Expert software questions (for Windows 95, Windows 98, and Windows NT 4.0 users, make sure you check the Quick Tour first)
› (310) 974-1983 for the EPSON Photo!2 application and TWAIN driver, the EPSON Photo File Uploader, the EPSON Photo!2 Program Uploader, and the Direct Print software.

Software Licensing
You can install EPSON Photo!2, the EPSON Photo File Uploader, and the EPSON Photo!2 Program Uploader on multiple computer systems. If you want to install Image Expert on multiple computer systems, please contact Sierra Imaging at (800) 501-8902 regarding the licensing fee.

Registration
Please take a minute to fill out the registration card for the PhotoPC 750Z digital camera and mail it back to us. This enables you to receive special information on accessories, new products, and software upgrades. You’ll get immediate attention if you have a problem with your PhotoPC 750Z.

Safety Instructions
Read all of these instructions before using your camera and battery charger. Also follow all warnings and instructions marked on the camera, battery charger, and batteries.

› To reduce the risk of electric shock, do not remove the camera’s cover or open any of the compartments except as instructed in Getting Started and this User’s Guide.
› To prevent fire or electric shock, do not insert objects through any openings in the camera or battery charger. Do not expose the camera or battery charger to rain or moisture.
To prevent fire or explosion, do not use the camera or battery charger where inflammable or volatile gas is stored.

If the camera shows unusual signs such as noise, odor, or smoke, turn it off immediately. Remove the batteries and/or disconnect the AC adapter, and unplug the AC adapter from the electrical outlet.

If the battery charger shows unusual signs such as noise, odor, or smoke, unplug it immediately.

To avoid damage to the optics of the camera, do not expose the lens to direct sunlight for extended periods of time.

Do not use the charger near water. Never insert or remove the charger’s power plug with wet hands.

Keep the charger away from heat sources. Do not use outside the temperature range of 32 to 95°F (0 to 35°C).

Do not use the charger within reach of children.

Use only the types of power sources listed on the charger label and in *Getting Started* and this *User’s Guide*. Always supply power to the charger directly from a standard domestic electrical outlet.

Do not use the camera outdoors during adverse weather conditions.

Do not store the camera near sources of bright light, direct sunlight, high humidity, heat, excessive dirt or dust, or where it will be exposed to strong vibrations or magnetic fields.

To prevent possible eye injury, do not take flash pictures of faces at close range.

Avoid sudden temperature changes, which can cause moisture to condense on the camera. Keep the camera in a case or bag if you need to move it from a cold environment to a warm one. Allow time for the camera and its optional accessories to adjust to temperature changes before using them.

Do not use a frayed or damaged power cord with the AC adapter.

*Introduction* 7
Remove batteries and/or unplug the camera and the AC adapter and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the camera; if the camera has been dropped or its exterior has been damaged; if the camera or its optional accessories do not operate normally or exhibit a distinct change in performance.

Adjust only those controls that are covered by the operating instructions.

Do not attempt to service the camera or battery charger yourself. Refer all servicing to qualified service personnel.

If the liquid crystal solution contained in the display panel or in the LCD screen leaks out and gets on your hands, wash them thoroughly with soap and water. If it gets in your eyes, flush them immediately with water.
Using Advanced Camera Features

The PhotoPC 750Z has advanced features for taking specialized photos. These features are described in the following sections:

- Taking pictures with the timer
- Using macro mode to take close-ups
- Taking digital panoramic pictures
- Taking digital zoom pictures
- Using the view mode menus
- Continuous shooting
- Taking quick shots
- Taking HyPict mode pictures
- Using advanced settings
- Using slow synchronized flash mode for night photos

FOR SALE

• 1995 Mitsubishi Montero
• Good condition
• Low Mileage
999-555-5555
Jim Jackson’s Auto Sales
Taking Pictures With the Timer

Setting the timer creates a 10-second delay between the time you press the shutter button and the actual image capture. This allows you to take a picture of yourself.

Follow these steps to take a picture with the timer:

1. Secure the camera on a flat surface or on a tripod and remove the lens cover. (See page A-2 for information on attaching the camera to a tripod.)
2. Slide down the camera dial lock and turn the camera dial to On or View. Wait until the status light turns green.
3. Press the timer button. The timer icon appears on the display panel.
4. Press the shutter button. The timer icon and the red timer light on the front of the camera flash slowly for 8 seconds. Then they flash rapidly for 2 seconds before the shutter is released.

The camera beeps when the image is captured. The status light on the back of the camera flashes red as PhotoPC 750Z processes the image. When the status light stops flashing and turns green, you can take another picture.

5. To turn off the timer, press the timer button again or turn off the camera.

Using Macro Mode to Take Close-ups

With the LCD screen, you can use the camera’s macro mode to take pictures as close as 8 inches (20 cm). Follow these steps:

1. Turn the camera dial to the View position. You see a live preview on the LCD screen.
2. Press the Mode button on the back of the camera.

For a few seconds, the word MACRO appears on the LCD screen, and the frame around the image turns green.

3. Press the shutter button halfway to lock the auto focus. The status light turns orange, and a small green circle appears in the upper right corner of the screen. While you hold the button down, you can reframe your picture if you want.

4. Press the button all the way down to capture the image.

5. To turn off macro mode, press the mode button three times or turn off the camera.

**NOTE**
When you take macro close-ups, you should use a tripod (as described in Appendix A) and disable the flash. Otherwise, your pictures may appear blurry and washed-out.

### Taking Digital Panoramic Pictures

Images in the digital panorama format are long and narrow, although they are not captured at a wider angle than normal images. Strips at the top and bottom of the image area are cropped out. Smaller file sizes mean you can store more pictures in the panorama format.

Make sure the camera dial is set to View, and follow these steps to take a panoramic picture:

1. Press the Mode button twice.
The word PANORAMA appears briefly on your screen and black margins appear at the top and bottom of the LCD screen, and you see the panorama icon at the bottom.

You can use the image quality button on top of the camera to select fine, super fine, monochrome fine, or monochrome super fine image quality (all at 1280 × 480 pixels); or HyPict or monochrome HyPict (both at 1600 × 600 pixels).

2 Press the shutter button halfway to lock the auto focus. The status light turns orange, and a small green circle appears in the upper right corner of the screen. While you hold the button down, you can reframe your picture if you want.

3 Press the button all the way down to capture the image.

The Panorama format remains active until you press the mode button twice or turn off the camera.

NOTE
You can't use panorama mode when taking pictures with continuous shooting (see page 1-7).

The following examples show the same subject captured in standard, digital zoom, and digital panorama formats:
Taking Digital Zoom Pictures

Digital zoom pictures are magnified two times (2×). This format is like a digital version of telephoto. The automatic cropping effect makes file sizes smaller, allowing you to store more pictures in the digital zoom format.

Make sure the camera dial is set to View, and follow these steps to take a digital zoom picture:

1. Press the Mode button three times.
   The word D-ZOOM appears on your LCD briefly. An orange frame appears around the previewed image, and the digital zoom icon is displayed at the bottom of the screen.

2. Press the shutter button halfway to lock the auto focus.
   The status light turns orange, and a small green circle appears in the upper right corner of the screen. While you hold the button down, you can reframe your picture if you want.

3. Press the button all the way down to capture the image.

The zoom format remains active until you press the Mode button again or turn off the camera.

NOTE
Since the digital zoom mode crops the image and magnifies it, it is best to print the image in a smaller format.

Using the View Mode Menus

You can use the view mode on the LCD screen to use advanced settings and control the display of information. Make sure your lens cover is off, then follow these steps to access the menus:

1. Slide down the camera dial lock and turn the camera dial to the View position.

   The lens moves out and you see a preview of your picture on the LCD screen.
2 Press the SEL (select) button.

Blue menu icons appear at the top of the screen, with the currently selected menu highlighted in orange. The settings for this menu are displayed on the screen as shown:

3 Press the ◀/▲ and ▶/▼ buttons to view the settings for other menus. The orange highlight indicates the currently selected menu.

You can choose from the following menus:

- **Conditions** (use advanced photo settings). See page 1-7 for instructions.
- **Settings** (change the date, time, beep, power setting, and LCD brightness). See page 6-9 for instructions.
- **Information** (turn off the display of information on previewed pictures). See page 2-5 for instructions.

4 To exit the menus, press the ESC button until the menu icons and settings disappear. (Depending on the menu, you may have to press this button several times to return to view mode.)

5 When you’re finished, turn the camera Off. (It will shut off automatically within 30 seconds.)
Continuous Shooting

In this mode, you can take two standard resolution pictures a second, with up to sixteen pictures in a sequence. You can capture a complex motion, such as a golf swing, in a series of steps to create animation sequences for the Internet, screen savers, or presentations.

NOTE
You can’t use the flash for continuous shooting, so make sure you have adequate lighting for your pictures. In addition, you can’t use the panorama or digital zoom features with continuous shooting.

Make sure the camera dial is set to View, and follow these steps to take a rapid sequence of pictures:

1. Press the SEL button to display the menus.

2. Press < or > to display the Conditions menu:

   Conditions
   Off
   Auto
   Std.

3. Press the SEL button to display the menu options:

   Conditions
   [Auto/Manu.]
   Off
   On
   Auto
   Manu
   Auto + 0.0
   Std.
4 Press button until cont/quick is selected and then press SEL to view the continuous/quick shot menu.

5 Press or to change the setting to Cont.

6 Press SEL, then press the ESC button twice to return to view mode.

A red frame appears around the previewed image, and the word CONTINUOUS appears briefly. You see the continuous shooting icon at the bottom of the screen. The display panel shows a blinking arrow next to the Cnt (continuous) symbol.

7 Press and hold the shutter button all the way down. The status light flashes red and the camera beeps as it captures each picture.

8 Release the shutter button when you have captured the pictures you want. The red light flashes as the camera processes the images.

9 To switch back to normal picture taking, follow steps 1 through 5 above, but turn off the continuous mode.

**Automatic Continuous Shooting**

You can combine continuous shooting with the timer for delayed automatic capture of sixteen images in eight seconds. This allows you to photograph yourself in motion. Follow these steps:

1 Secure the camera on a flat surface or on a tripod. (See page A-2 for information on attaching the camera to a tripod.)

2 Turn the camera dial to View.
3 Follow steps 1 through 5 on page 1-8 to select continuous shooting.

4 Press the timer button.

The timer icon appears on the display panel.

5 Press the shutter button.

The timer icon and the red timer light on the front of the camera flash slowly for 8 seconds. Then they flash rapidly for 2 seconds before the shutter is released.

You have 10 seconds to get ready for “action” in front of the camera.

The camera beeps 16 times as it captures your images, and the red light flashes as the images are processed.

6 To switch back to normal picture taking, follow steps 2 and 3 above, but turn off the continuous mode.

Taking Quick Shots

You can take as many images as the camera can temporarily store with quick shot mode. Normally, the camera takes a few seconds to process each image and you have to wait to take the next picture. In quick shot mode, the camera stores the images in its 4MB DRAM while you keep taking pictures. It saves the images to the internal memory or CompactFlash card after you are done.

Make sure the camera dial is set to View, and follow these steps to use quick shot mode:

1 Press the SEL button to display the menus.

2 Press or to display the Conditions menu:

You can take as many images as the camera can temporarily store with quick shot mode. Normally, the camera takes a few seconds to process each image and you have to wait to take the next picture. In quick shot mode, the camera stores the images in its 4MB DRAM while you keep taking pictures. It saves the images to the internal memory or CompactFlash card after you are done.
1-10 Using Advanced Camera Features

3 Press the SEL button to display the menu options:

4 Press ▼/▲ button until cont/quick is selected and press SEL to view the continuous/quick shot menu.

5 Press ▼/▲ to change the setting to Quick.

6 Press SEL, then press the ESC button twice to return to view mode.

**NOTE**
You must hold down the Function button to take quick shot pictures.

You can’t use the Quick Shot mode to take HyPict mode pictures. The camera needs approximately 20 seconds to process each HyPict image.

**Taking HyPict Mode Pictures**
The PhotoPC 750Z features a new Epson technology called HyPict. In this mode, the PhotoPC 750Z captures images at 1280 × 960 pixels, and then interpolates them up to 1600 × 1200 pixels inside the camera, before compressing them into JPEG format. In HyPict mode, you can enlarge and print ultra-high resolution photos without compromising detail and image quality. Follow these steps to enable HyPict mode:

1 Press the SEL button to display the menus.

2 Press ▼/▲ or ▼/▲ to display the Conditions menu:
3 Press the SEL button to display the menu options:

4 Press button until HyPict is selected and then press SEL to change the setting to On.

5 Press the ESC button twice to return to view mode.

NOTE
When you are ready to take a picture, press the image quality button a few times until you select HyPict or Monochrome HyPict as your image quality setting. (See Chapter 4 in Getting Started for more information about image quality settings.)

Using Advanced Settings
You can choose from the following settings for advanced photographic controls:

- User defined or fixed white balance (for “warm” indoor pictures or more brilliant sunsets)
- Manual exposure control (provides 8 levels of exposure, ±2 steps)
- Sensitivity control (for night photography, with 3 levels)

Use the instructions in the following sections to take pictures with advanced settings.

Using White Balance
Normally, the PhotoPC 750Z adjusts the white balance of your pictures automatically. This means that both outdoor and indoor pictures have accurate colors, without a “bluish” or “yellowish” appearance.
However, you can have the camera use a fixed white balance for a warmer appearance under fluorescent lighting or special effects, such as a red-tinted sunset. The white “color temperature” of the fixed setting is 5200 degrees Kelvin. Or, you can set the white balance yourself.

**Photographing With Fixed White Balance**

Make sure the camera dial is set to View, then follow these steps to take pictures with fixed white balance:

1. Press the SEL button to display the menus.
2. Press or to display the Conditions menu:

3. Press the SEL button to display the menu options:

4. If the advanced settings are set to Auto (gray and not selectable), highlight the Auto/Manual advanced settings icon and press the SEL button.

5. Press to highlight the white balance icon.

6. Press the SEL button to view the white balance menu.

7. Press or to change the white balance setting to Lock and press SEL. (The white balance setting is locked at 5200°K.)

8. Press the ESC button twice to return to view mode.

*1-12 Using Advanced Camera Features*
An arrow appears next to the WB (white balance) symbol on the display panel.

9 Take pictures with the LCD screen as usual. (See page 3-9 in *Getting Started* for instructions.)

10 To switch back to auto white balance, follow steps 1 through 6 above, but change from Lock to Auto.

**Photographing With User Defined White Balance**

Make sure the camera dial is set to View, then follow these steps to take pictures with fixed white balance:

1 Press the SEL button to display the menus.

2 Press  or  to display the Conditions menu:

3 Press the SEL button to display the menu options:

4 If the advanced settings are set to Auto (gray and not selectable), highlight the Auto/Manual advanced settings icon and press the SEL button.

5 Press  to highlight the white balance icon .

6 Press the SEL button to view the white balance menu.

7 Press  or  to change the white balance setting to (Setting) and press SEL.

The LCD screen shows a live preview and indicates the area that will be used for the setting.
Focus the camera on a piece of white paper, or some other object to set the white balance by, and press the shutter button to save the setting.

Press ▼/▲ to select User and press the SEL button.

Press the ESC button twice to return to view mode. An arrow appears next to the WB (white balance) symbol on the display panel.

Follow the instructions on page 3-9 in Getting Started to take pictures with the LCD screen as usual.

To switch back to auto white balance, follow steps 1 through 6 above, but change from User to Auto. Then press the ESC button twice to return to view mode.

NOTE
You can’t set a user-defined white balance if your camera memory is full.

Adjusting Exposure

Your camera normally adjusts exposure automatically. If you want to lighten or darken a photo before you take it, you can use the manual setting, and adjust the exposure by hand for any photo you take.

Make sure the camera dial is set to View, then follow these steps to take pictures with manual exposure adjustment:

1. Press the SEL button to display the menus.
2. Press ▼/▲ or ▶/▼ to display the Conditions menu.
3 Press the SEL button to display the menu options, as shown.

4 If the advanced settings are set to Auto, highlight the Auto/Manual advanced settings icon and press the SEL button.

5 Press ▶/◀ until the exposure icon is highlighted and press the SEL button to view the exposure menu.

6 Press ▶/◀ to change from Auto and press the SEL button.

7 Press ▶/◀ or ▶/◀ to select an exposure value and press SEL.

8 Press the ESC button twice to return to view mode. The manual exposure icon appears in the upper left corner of the screen.

9 Any time you want to change the value, hold the Function button and use the arrow keys to lighten or darken the image. As you change the setting, you see plus or minus indicators on the display panel and the upper left corner of the LCD screen.

Press ▶/◀ once to make the image one half step lighter (+0.5); press ▶/◀ again to make it one whole step lighter (+1.0). You can go to two steps lighter than the normal exposure. This is useful when your picture has a bright background, for example, windows facing the sun.
Press ▶/◀ to make the image one half step darker (~0.5); press ▶/◀ again to make it one whole step darker (~1.0). You can go to two steps darker than the normal exposure. This is useful when you’re photographing an object with a dark background.

10 Take your pictures with the LCD screen as usual, following the instructions on page 3-9 in Getting Started. If you’re not sure about the lighting conditions, you may want to take several photos with various exposure settings.

11 To switch back to automatic exposure, follow steps 1 through 6 above, but change the setting to Auto.

**Adjusting Sensitivity for Night or Indoor Photos**

The camera’s high sensitivity settings let you take pictures in low light or indoors without the flash. With these settings, you can set the camera from the camera’s standard ISO equivalent of 90 to an ISO equivalent of 180 or 360.

Make sure the camera dial is set to View, then follow these steps to use the high sensitivity mode to take night photos:

1. Press the SEL button to display the menus.
2. Press ▶/◀ or ▶/◀ to display the Conditions menu:

   ![Conditions Menu](image)

3. Press the SEL button to display the menu options:

   ![Conditions Options](image)

4. If the advanced settings are set to Auto, highlight the Auto/Manual advanced settings icon ▶/◀ and press the SEL button.
5 Press \[\text{\textasciitilde}/\text{\textasciitilde}\] to highlight the sensitivity icon and click SEL to display the sensitivity menu:

![Conditions Menu]

6 Press \[\text{\textasciitilde}/\text{\textasciitilde}\] or \[\text{\textasciitilde}/\text{\textasciitilde}\] to change from Std (ISO 90) to Med (ISO 180) or High (ISO 360) and press SEL.

7 Press the ESC button twice to return to view mode.

8 Take your pictures with the LCD screen as usual, following the instructions on page 3-9 in Getting Started.

9 To switch back to the standard sensitivity setting, follow steps 1 through 6 above, but change from Med or High to Std.

---

**Using Slow Synchronized Flash Mode for Night Photography**

To light up the background as well as your subject, use the slow synchronized flash mode when taking pictures at night. This option causes the aperture to stay open longer, allowing more light to enter the camera.

Set the camera dial to View, then follow these steps:

1 Press the SEL button to display the menus.

2 Press \[\text{\textasciitilde}/\text{\textasciitilde}\] or \[\text{\textasciitilde}/\text{\textasciitilde}\] to display the Conditions menu:

![Conditions Menu]

---

*Using Advanced Camera Features* 1-17
3. Press the SEL button to display the menu options:

4. If the advanced settings are set to Auto, highlight the Auto/Manual advanced settings icon and press the SEL button.

5. Press ▲/v to highlight the flash icon.

6. Press SEL to change from Std to Slow.

7. Press the ESC button twice to return to view mode.

8. Take your pictures with the LCD screen as usual. (You can follow the instructions on page 3-9 in Getting Started.)

9. To switch back to the standard setting, follow steps 1 through 6 above, but change from Slow to Std.
Playing Back Photos

The LCD screen lets you play back your pictures one-by-one or in groups of nine at a time. You can magnify or erase selected pictures and customize playback features through the LCD screen menus. You can view your pictures on a television just as easily as on the camera’s screen. This chapter explains the following:

- Using playback mode
- Playing back pictures one-by-one
- Playing back multiple pictures
- Playing pictures as a slide show
- Turning off picture information
- Magnifying a picture
- Erasing pictures
- Playing back pictures on TV
Using the Playback Mode

Follow these steps to use the camera’s playback mode:

1. Push down the camera dial lock and turn the camera dial to Play.

The last photo you took appears on the LCD screen.

2. To access the screen menus, press the SEL button. Blue menu icons appear at the top of the screen with the currently selected menu displayed in orange.

   The settings for this menu are displayed on the screen, as shown:

   ![Menu Icon Example](image)

3. Press the < and > buttons to view the settings for other menus.

   You can choose from the following menus:

   - **Settings** (date, time, beep, power-save mode, and LCD brightness). See pages 6-8 to 6-12 for more information.
Information (turn off the display of information on played-back pictures). See page 2-5 for instructions.

Playback Mode (display one at a time or groups of 9 images). See page 2-4 for instructions.

Magnification (zoom in on a picture and view it in sections). See page 2-6 for instructions.

Photo Control (erase, lock, display memory information, or work with flash memory cards). See pages 2-7 to 2-12 and Chapter 10 for instructions.

Slide Show (play back pictures automatically). See page 2-5 for instructions.

Software (print directly from the camera or add/remove the Direct Print program). See Chapter 9 for instructions.

Language (select language for LCD display and menus). See page 6-12 for instructions.

4 To exit the menus, press the ESC button until the menu icons and settings disappear. (Depending on the menu, you may have to press this button several times.)

5 When you’re finished with playback mode, turn the camera dial Off.

Playing Back Pictures One by One

When you set the camera dial to Playback, you see the last picture you took on the LCD screen, along with the date, time, and picture information:
Press the ▶/◀ button to display the earliest picture taken. You can continue pressing the button to view your pictures in order. Press ◀/▶ to move backward through your pictures.

**Playing Back Multiple Pictures**

You can play back your pictures in Multi mode to view small “thumbnail” versions of nine pictures at once. Make sure the camera dial is set to Play, and follow these steps:

1. Press the SEL button to display the screen menus.
2. Press ◀/▶ or ▶/◀ until you see the Playback Mode menu.
3. Press the SEL button again to choose the Multi setting, then press the ESC button to exit the menus.

4. Press the ▶/◀ and ◀/▶ buttons to move the white selection frame through the images on screen. When the frame passes the first or last photo of the current group, the previous or next three images are displayed in the group.

Thumbnail images of the last photos you took appear on the screen, with the currently selected image framed in white, as shown below.
Playing Back Photos  2-5

To switch back to displaying one picture at a time, follow steps 1 through 3 again, but choose the Normal setting on the Playback Mode menu.

Playing Your Pictures as a Slide Show

You can use the LCD screen to display your pictures automatically. Make sure the camera dial is set to Play, and follow these steps:

1. Press the SEL button to display the LCD screen menus.
2. Press the ◀/◀ or ▶/▶ button until you see the Slide Show option.
3. Press the SEL button again. The LCD screen begins playing back your pictures one by one, with the image numbers appearing in the bottom right corner.

To move forward or back through the photos manually or reverse the direction of the slide show, press the ◀/◀ or ▶/▶ button.

To pause the slide show at a particular photo, press the SEL button. The pause icon  appears next to the picture count on the screen. Press SEL again to resume the slide show.

4. To stop the slide show, press the ESC button. Press ESC again to return to normal playback mode.

Turning Off Picture Information

The LCD screen displays the time and date of each picture along with other information. You can turn off the information display if you want.

Make sure the camera dial is set to Play, and follow these steps:

1. Press the SEL button to display the LCD screen menus.
2. Press the \(</<\) or \(>/>/\) button until you see the Information menu.

3. Press the SEL button to turn information Off. You can press it again to turn information back on.

4. To save your setting, press the ESC button.

You can also turn off information displayed in view mode. Turn the camera dial to View and follow the steps above.

**Magnifying a Picture**

You can zoom in to magnify a portion of your image on the LCD screen and view it in greater detail. Then you can use the arrow buttons to scroll the image and display another section (up to nine sections for regular images and three sections for panoramic images).

The sections of your image that can be viewed are demonstrated in the figure below:

![Magnification Icon](image)

Make sure the camera dial is set to Play, and follow these steps:

1. Press the SEL button to display the LCD screen menus.

2. Press the \(</<\) or \(>/>/\) button until you see the Magnification option.

3. Press the SEL button to zoom in on the center of your image. A small icon \(\square\) in the upper left corner shows which section of your image is currently displayed.
4 Use the \(<\/\) and \(\triangleright\triangleright\) buttons to move the display left or right. To move the display up or down, hold down the Function button and press the \(<\) or \(\triangleright\) buttons. The icon indicates which section is displayed.

5 Press the ESC button to return to normal view. Press ESC again to exit the menu.

**Erasing Pictures**

The LCD screen provides two different methods for deleting images after you play them back:

- You can delete the currently displayed picture
- You can select pictures for deletion or “lock” (protect) them from deletion

You can also erase photos through your software when the camera is connected to your computer. For instructions, see *Getting Started* and Chapter 3.

**Erasing the Currently Displayed Picture**

Make sure the camera dial is set to Play and the image you want to erase is displayed. Then follow these steps:

1 Hold down the Function button and press the ESC button.

You see the following message on the LCD screen:

![Confirmation](image)

2 Press the SEL button to erase the picture. The picture is erased and the screen returns to playback mode.

---

**NOTE**

If you try to erase a locked photo, you see a warning message. Press any button to clear the message. See pages 2-9 to 2-12 for instructions on locking and unlocking images in the camera.
Selecting Pictures to Erase

You select pictures to erase using the Photo Control menu. You can either select individual pictures, or choose to erase all the pictures in the camera. Using the same menu, you can select pictures to lock (protect from erasing) or lock all pictures. See pages 2-9 to 2-12 for information about locking and unlocking pictures.

Make sure the camera is set to Play, and follow these steps to erase pictures:

1. Press the SEL button to display the LCD screen menus.
2. Press the or button until you see the Photo Control menu, then press the SEL button to display the menu options:

3. Press the SEL button to enter the Erase mode. The following menu is displayed:

   Erase Photos
   Select Photo
   Erase All

4. Press the or button to choose Select Photo or Erase All:
   - If you want to erase just one or some of the photos, choose Select Photo. Then continue with Step 5.
   - If you choose Erase All. Then press the SEL button. A message appears asking you to confirm that you want to erase the photos. Press the SEL button to erase the photos; or press the ESC button to return to the Photo Control menu without erasing the photos.

5. Press the SEL button, then press the or button to move through the images in the camera until the photo you want appears on the screen.
6 Press the SEL button. An orange frame appears around the image. If you want to erase other photos at the same time, use the ◄/► or ◄/↑ button to display them, then press the SEL button to select them.

NOTE
To cancel the selection of a photo, simply highlight it and press the SEL button again.

7 When you have selected all the photos you want to erase, press the ESC button. A message appears asking you to confirm your selections.

8 Press the SEL button to erase the images and return to the Erase Photos menu.

NOTE
If there are locked photos in your camera, a message appears on the screen before the confirmation message. Press the SEL button to erase only the unlocked images from the camera. (If you want to erase locked photos, you must unlock them first.)

9 Press ESC until you return to normal playback mode.

Locking Photos
The lock feature allows you to keep your photos from being accidentally erased. You can lock selected photos or all the photos in the camera.

Make sure the camera dial is set to Play, then follow these steps to lock pictures:

1 Press the SEL button to display the LCD screen menus.

2 Press the ◄/► or ◄/↑ button until you see the Photo Control menu, then press the SEL button to display the menu options:
3 Press the ▶/🌅 button until Lock is highlighted in orange, then press the SEL button to view the Lock Photos menu:

4 Press the ◄/◄ or ►/🌅 button to choose Select Photo or Lock All:
   - If you want to lock just one or some of the photos, choose Select Photo. Then continue with step 5.
   - If you want to lock all the photos, choose Lock All. Then press the SEL button. A message appears asking you to confirm that you want to lock all the photos. Press the SEL button to lock the photos. Then press the ESC button until you return to normal playback mode.

5 Press the SEL button, then press the ◄/◄ or ►/🌅 button to move through the images in the camera until the photo you want to lock appears on the screen.

6 Press the SEL button. A lock icon ✎ appears next to the frame number. If you want to lock other photos, use the ◄/◄ or ►/🌅 button to display them, then press the SEL button to select them.

   NOTE
   To cancel the selection of a photo, press the SEL button again.

7 When you have selected all the photos you want to lock, press the ESC button. The following message appears:

   Confirmation
   Lock/unlock photos?
   Yes: SEL.
   No: ESC
Playing Back Photos  2-11

Unlocking Photos
After you have locked some of your pictures, you can unlock selected photos or all the photos in the camera.

Make sure the camera dial is set to Play, then follow these steps to unlock pictures:

1. Press the SEL button to display the LCD screen menus.
2. Press the \ or \ button until you see the Photo Control menu, then press the SEL button to display the menu options:

   **Photo Control**
   - **Erase**
   - **Lock**
   - **Photo Info**
   - **Copy**
   - **Format Card**

3. Press the \ or \ button until Lock is highlighted in orange, then press the SEL button to view the Lock menu:

   **Lock Photos**
   - **Select Photo**
   - **Lock All**
   - **Unlock All**

4. Press the \ or \ button to choose Select Photo or Unlock All.
   - If you want to unlock just one or some of the locked photos, choose Select Photo. Then continue with step 5.
   - If you want to unlock all the locked photos, choose Unlock All. Then press the SEL button. A message appears asking you to confirm that you want to unlock all the photos. Press the SEL button to unlock the photos. Then press the ESC button until you return to normal playback mode.
5 Press the SEL button, then press the ◼ or ▶ button to move through the images in the camera until the photo you want to unlock appears on the screen.

6 Press the SEL button. The lock icon disappears from the screen. If you want to unlock other photos at the same time, use the ◼ or ▶ button to display them, then press the SEL button to select them.

NOTE
To cancel the selection of a photo, press the SEL button again.

7 When you have selected all the photos you want to unlock, press the ESC button. The following message appears:

8 Press the SEL button to unlock the images.

9 Press ESC until you return to normal playback mode.

Playing Back Pictures on TV
You can display your pictures on a regular television or VCR by using the video cable that came with your PhotoPC 750Z.

TIP
You can videotape your pictures to share them without using a computer. After you connect the camera to your VCR, press the Record button on the VCR and set the camera’s LCD screen to Slide Show.

Follow these steps to play back your pictures on TV:

1 Make sure the camera and TV (and VCR) are turned off.
2 Open the camera’s connector cover and connect the black end of the video cable to the Video Out port as shown:

3 Connect the yellow end of the cable to the VIDEO IN port on the television or VCR:

4 Turn on the TV (and VCR) and switch to the correct video mode.
5 Turn the camera dial to **Play**. The last picture you took appears on the TV screen. You can use all of the camera’s playback features when your pictures are displayed on TV.

---

**NOTE**

*Using the optional AC adapter is highly recommended when you play back your pictures on a TV. See page A-1 for instructions and ordering information.*
PhotoPC 750Z provides several methods for getting your pictures into applications and projects. You can drag and drop a picture from an Image Expert album into a document or presentation. You can also import an image into your application, or copy and paste it. You can use the Camio™ Viewer to drag a picture directly from the camera and drop it into your project. This chapter describes the following:

- Getting images into TWAIN applications
- Getting images that you can import
- Importing images into documents
- Getting images with copy and paste
- Using drag and drop from an album
- Getting images with the Camio Viewer

**NOTE**

Although most of the instructions and illustrations in this chapter apply to Windows 95 or Windows 98, you can follow the same steps on a Macintosh or a different version of Windows.

### Getting Images Into TWAIN Applications

If you use Photoshop® or other TWAIN-compliant applications, you can transfer your pictures directly into your program from the camera. Follow these steps:

1. Start your application.

2. Choose Import, then Select TWAIN_32 Source (or Acquire, then TWAIN Select Source) from the File menu.
3. Choose EPSON PhotoPC 750Z-600 as the TWAIN source.

4. Choose Import, then TWAIN_32 (or Acquire, then TWAIN Acquire) from the File menu.

5. The EPSON Photo!2 screen appears, with “thumbnail” images of your pictures, as shown below.

If you see a Setup screen that says The Camera Is Not Responding, see page 3-5.

6. Select the picture you want and click Get Photos to transfer the picture. Or, click Select All, and then Get Photos, to transfer all the pictures.

You can also select a picture and do the following before you transfer it:

- Click View Photo to see a full-size image.
- Click one of the rotate buttons to turn the picture 90 degrees.
- Click Photo Info to see the capture time and date, image resolution, and other information.
- Click PhotoEnhance to automatically improve the picture during transfer. (You can select and enhance all the pictures at once. However, using this feature will make the transfer take significantly longer. Not recommended without using the AC adapter.)
7 After transferring, click **Erase Photos** if you want to remove the picture(s) from your camera.

8 If necessary, click **Close** to exit the EPSON Photo!2 screen and return to your application. You see the picture or pictures in the work area.

**Getting Images That You Can Import**

Most methods of transferring images from the camera save your pictures as JPEG files. If your word processor or other application doesn’t support the JPEG format, you have to convert the files one by one. Or, you can use the export feature of EPSON Photo!2 to automatically convert the files as you transfer them.

Follow these steps to transfer and export your pictures with EPSON Photo!2:

1 Start your EPSON Photo!2 software. Under Windows 98, Windows 95, or Windows NT 4.0, click **Start**, and then point to **Programs, PhotoPC 750Z, EPSON Photo!2.**

You see a screen like the one below. (If you see a Setup screen that says **The Camera Is Not Responding**, see page 3-5.)

2 Click the picture you want, or click **Select All.**

You can also view, rotate, or enhance the picture(s) or see picture information before you transfer, as described on page 3-2.
3 Click the **Export Photos** button. The Save As dialog box appears:

4 Type a file name. If you're transferring more than one image, the software will add numbers to identify each one.

5 Select the file type from the pull-down menu. You can choose any of the following formats:
   - Bitmap (BMP)
   - JPEG
   - PCX
   - PICT (Macintosh only)

6 Click **Save**. Your pictures are transferred one by one.

   **NOTE**
   You cannot open exported photos in EPSON Photo!2. Use Image Expert to view and edit the exported images.

7 Click **Erase Photos** if you want to remove the pictures from your camera.

8 Click **Close** to exit EPSON Photo!2.

You can now insert your exported pictures in documents and other projects. For instructions, see page 3-6.
Here are some of the additional things you can do with EPSON Photo!2:

- Select the **Folder** tab and click **Browse** to locate and display pictures you have downloaded. You can then select a picture and click **Upload Photos** to transfer a picture from your computer to the camera or an optional memory card. See Chapter 7 for more information.

- Select the **Controls** tab to change camera settings or view a live preview and take pictures from your computer. See page 6-4 for more information.

- Set the camera’s date and time from the **Setup** tab, or change your computer connection settings. See page 6-8 for more information.

**What To Do If the Camera Is Not Responding**

When you try to acquire pictures from the camera or start the EPSON Photo!2 application, you may see a screen with the following message:

```
The Camera Is Not Responding!
Please check the following:
- Camera is On
- Cable is Connected
- Battery Level / AC Power
Then, press “Test Connection”.
```

Follow these steps to fix your camera connection:

1. Make sure the camera is turned on and has not shut off automatically. If it has, turn the camera dial **Off** and then back **On**.
2 Check the cable and make sure the connections are secure. Make sure the pins inside the connector are not bent.

3 Make sure your batteries have enough power, or your AC adapter is connected.

4 Click Test Connection. If you see the same screen, continue with step 5.

5 Select another port if necessary. In most cases, it is best to leave the Port setting at Auto because EPSON Photo!2 can detect the camera connection automatically. If you have a serial device connected to one port and an internal modem on the other, you can try COM3 or COM4.

6 Select a slower speed. EPSON Photo!2 automatically chooses the fastest speed that works with your system. This may actually be too fast for the configuration of your port. Try setting the speed to 57600. You may need to experiment to choose the best speed.

7 Click Test Connection again. If you still don’t see your pictures, see Chapter 10 for more troubleshooting tips.

Importing Images Into Documents

Once your pictures are transferred and saved on your hard drive, you can import them into your applications. You may need to convert your images if you didn’t export them from the camera (as explained on page 3-3) and your application can’t import JPEG files. Or, you can use the Save As feature of Image Expert to convert image files.

NOTE Your picture may display poor image quality after you import it. However, in most cases it will print correctly.

Follow these steps to import a PhotoPC 750Z picture into your document:

1 Start your application.

2 Open the document where you want to use the picture.
3. Select the point where you want to place your picture.

4. Select Picture from the Insert menu. (In some applications you may need to select a different command, such as Import Picture, which is usually in the File or Insert menu.)

An Insert Picture dialog box appears:

5. Locate and select the image you want to insert. In some applications you can see a preview of your picture.

6. Click OK (or Insert, Import, or whatever command your application uses) to insert your picture. The picture appears in your document.
NOTE
In some applications, you can add a frame around the picture if you want to move it around on the page or resize it. In other applications, you create a frame first, and then place the picture in it. For instructions, see your application’s online help or documentation.

Getting Images With Copy and Paste
You can use this method to place a picture in just about any type of document or project. Follow these steps:

1. Open your picture in Image Expert.
2. Click the Copy button or select Copy from the Edit menu.
3. Start your word processor or other application.
4. Open the document where you want to use the picture.
5. Choose Paste (or Paste Special) from the Edit menu. A copy of the picture appears in your document.

Using Drag and Drop From an Album (Not Available in All Operating Systems)
Once you have transferred your pictures into albums, you can easily drag and drop them into documents or other projects.

NOTE
Dragging and dropping an image into a document works only with OLE-2.0-compliant applications, such as Microsoft Word®, PowerPoint®, WordPerfect®, or Lotus SmartSuite®. Depending on how well your application supports OLE 2.0, your images may not look as good when you drag and drop them as when you import them.

Follow these steps:

1. Start Image Expert as described in Chapter 4.
2. Click View Pictures from an Existing Album.
Or, from the Image Expert screen, click the Open Album button or select Open Album from the File menu. You see a dialog box like the following:

3 Locate the album you want and double-click the album name to open it.

4 Start your word processor or other application.

5 Open the document where you want to use the picture. You should have both the Image Expert album and the document displayed on your screen, as shown:

6 Click the image you want.

7 While holding down the mouse button, drag the image to the location where you want it in your document.
Release the mouse button. The picture appears in your document.

If you want to edit or modify the picture, just double-click it to bring up the Image Expert menus and toolbar. (See Chapter 5 for more information on editing images.)

**Getting Images With the Camio Viewer (Windows 95, Windows 98, and Windows NT 4.0)**

The Camio Viewer, which runs under Windows 95, Windows 98, or Windows NT4.0, is a quick and easy way to get pictures from the camera. You can transfer all the images to your computer, or just display the pictures in the camera. Then you can drag a picture directly into a presentation or document.

---

**NOTE**

*Dragging and dropping an image with the Camio Viewer works only with OLE-2.0-compliant applications running under Windows 95, Windows 98, and Windows NT 4.0.*

---

First you need to connect the camera to your computer as described in Chapter 4. Then follow these steps:

1. Double-click the camera icon on the right end of your Windows Taskbar.

You see the Camio Viewer Startup Options dialog box:

![Camio Viewer Startup Options](image)

2. If you are trying to access the images on your camera, select **Connect Via Serial Port**. If you are using a PC card slot, select **Connect Via PC Card**.
3  Choose one of the following options:

- **View images in the Camera/PC Card**
  Displays a filmstrip of your pictures. You can then select an image to drag and drop into a document or presentation. (The image will be embedded in your document, and will not be available as a separate file.)

- **Copy all images from the Camera/PC Card to the Computer**
  Transfers your pictures to an album (folder) on your hard disk drive. You can then select an image to drag and drop.

- **Copy all images and delete them from the Camera/PC Card**
  Transfers your pictures to an album (folder) on your hard disk drive and deletes them from the camera. You can then select an image to drag and drop.

4  Continue with the steps in one of the following sections, depending on the option you chose in step 3.

---

**Dragging and Dropping a Picture Into a Document**

Follow these steps if you chose **View images in the Camera**:

1  Click OK. Your pictures appear in a strip of thumbnail images:

2  Open the application and document where you want to use the picture.
Click the picture you want to use. Without releasing the mouse button, drag the picture to your document. When your pointer is over the location where you want the picture to appear, release the mouse button. The picture is downloaded from the camera, and it appears in your document.

If you want to edit or modify the picture, just double-click it to bring up the Image Expert menus and toolbar. (Click your document outside the picture to return to the normal view.) For more information about the Camio Viewer, choose Quick Tour from the Image Expert Help menu.

Transferring Images Before Placing Them
Follow these steps if you chose Copy all images or Copy all images and delete them:

1. Click OK to copy your pictures to an album named with the current date. Or, type a new name for the album and click OK. Your pictures are transferred one by one. They appear in a strip of thumbnail images, as shown on the previous page.

2. Follow steps 2 and 3 in the previous section to drag and drop a picture into a document or other project.

NOTE
When you drag and drop with the Camio Viewer, your picture is not saved as a separate image file on your hard drive. You have to transfer your image first if you want it to be available as a separate image file.
Working With Photos and Albums

You can use Image Expert albums to organize and display your pictures. You can print using dozens of predefined layouts. On Windows systems, you can also record sounds for each image, copy an album to diskette, use your images as wallpaper, and more. This chapter covers the following:

- Using albums
- Printing an image or album
- Adding sound to an image
- Adding annotations
- Displaying albums as slide shows
- Using an album as a screen saver
- Setting an image as wallpaper
- Copying to diskette or Zip™ disk
- Sending pictures and sound by e-mail
Using Albums
Image Expert albums provide a convenient way to access and view your pictures. Here are some of the things you can do with albums:

- Organize pictures in albums
- Rename a picture
- View picture information

Organizing Pictures in Albums
Although Image Expert initially sorts your pictures by date, you can easily drag and drop images between albums to organize them by subject matter or in any way you want.

Follow these steps to copy or move images from one album to another:

1. Open the album you want to copy the images to and the album where the pictures are located.

If you want to create a new album, click the New Album button or select New Album from the File menu.

2. Select the image or images you want to move or copy. Hold down the Ctrl (Option on Macintosh) or Shift key to select multiple images.

3. To copy or move images, click inside one of the selected images and hold down the mouse button.

4. Drag the image(s) to the other album.
When the second album is highlighted, let go of the mouse button.

The images are copied to the album. You can sort the pictures and save or rename the new album.

**Renaming a Picture**

You can easily rename a picture displayed in an album. Follow these steps:

1. Click the picture to select it.
2. Double-click the name that appears above the picture.
   
The name is highlighted.

3. Type in the new name and press Enter or click outside of the name area. The new name appears above the picture and is saved.

**Viewing Picture Information**

You can display information about any image file and the camera settings that were used to capture it. Follow these steps:

1. Click the picture to select it or double-click it to open the image.

   ![My Album](image)
2 Click the Properties button or select Properties from the Image menu. You see information like the following:

3 Click the Camera Settings tab to display information like the following:

4 Click another image to view its information, or close the Properties box.

Printing an Image or Album

Image Expert offers many choices for printing an individual picture or album with titles, labels, or any text you want to add. You can print an image at full size (one per page) or choose the number of prints per sheet of paper. You can also specify a size or print combinations with standard sizes for framing.
Follow these steps to print:

1. Open the image or album you want to print.

2. Click the Print Layout button or choose Print Layout from the file menu.

   The Print Layout window appears:

   - Click to display next or previous page
   - Click to display list of sizes and layouts
   - Click to adjust margins

   The image in the center of the screen shows you a preview of your printout.

3. Follow the instructions in the sections below to adjust printer settings, choose your layout style, select album images, add text, and adjust the printed area for your images.

4. When you’re finished designing your layout, click the Print button to print out your picture(s).

   **NOTE**
   To print from Windows NT 3.51, click the Page Setup button or choose Page Setup from the File menu. You can add a title or footer to your page and print a contact sheet or select the number of images per page for albums. However, you can’t choose layout styles or use the other features described in this section.

**Choosing the Layout Style**

You can choose portrait or landscape orientation and select from a variety of layouts.
Follow these steps:

1. Click the **Print Setup** button if you need to select your printer or paper size. Otherwise, all layouts are set up for a standard letter-size sheet.

2. In Windows, click the **Portrait** button or **Landscape** button to change the orientation of the page.

3. Click the down arrow next to the size box to display the drop-down list of sizes and layout choices:

4. Choose the size and number of images you want per page. If you need a custom size, choose **Custom Size**. You can then enter exact dimensions for your picture or size it interactively in the layout window.

5. When the preview shows the layout you want, you can click the **Print** button or follow the instructions in the next sections to add text or make other adjustments to your printout.

---

*4-6 Working With Photos and Albums*
Adding Text
If you want to have image labels or page headers or footers printed with your pictures, follow these steps:

1. Click the Edit Text button. The Change Print Text dialog box appears:

   ![Change Print Text dialog box]

   Type here if you want your text centered under the picture or on the page. Otherwise, type it in the Left or Right box.

2. Select Page Header, Page Footer, or Image Label, and then type the text you want to use in the Left, Center, or Right boxes (depending on how you want it to display). You can type different text for each box.

3. Click Change Font to set the font size, style, color, and so on for your header, footer, or labels.

4. Click Insert Special Item to choose one of the following for your header, footer, or labels (only some of the choices are available for each):

   - Date Taken (%d)
   - Time Taken (%T)
   - Date Printed (%D)
   - Time Printed (%T)
   - Album Name (%n)
   - Image Name (%N)
   - Page Number (%p)

5. When you’re finished designing your text, click OK. The text is previewed on your layout in the center of the screen.

Working With Photos and Albums 4-7
Choosing Album Images
If you’re printing an album, Image Expert uses as many pages as necessary to print the entire album. If you don’t want to print all the images, you can choose the ones you want and position them in your layout. Follow these steps:

1. Click the Pick Images button . Your album appears in a “filmstrip” on the right side of your screen.

2. Choose the images you want to print, and drag each one where you want it to appear in the layout.

You may notice that some images are cropped. If you want to adjust the cropping, or zoom an image in or out, follow the instructions in the next section.

Adjusting the Printed Area
You can zoom in on an image, and then move it around to display just the portion you want. Follow these steps to adjust the printed area:

1. Double-click the image you want to adjust.
The other images fade out, and the sizing tools on the left side of the screen become active.

2 Click the Zoom In tool and then click on an image to enlarge and crop it.

You can also click the Zoom Out tool to reduce your image and display more of it.

3 Click the Move tool and then click on an image to move it and choose the portion you want to display.

4 Click the Reset Size button to return to the default size and layout.

5 When the preview shows the layout you want, you can click the Print button to produce your printout.

Adding Sound to an Image (Windows Only)

If you’re using Windows and your system includes a microphone and a 16-bit sound card with speakers, you can add voice or musical annotations to your pictures. Follow these steps to add sound:

1 Select the image you want to add sound to.
2 Click the Record button  on the left side of your screen or select Record Audio from the Annotation menu to open the Record dialog box:

3 Select the option you want:
   - To add sound to an image choose Record New.
   - To add additional sound to an existing audio clip, choose Record Additional.
   - To end your recording, choose Stop.
   - To listen to your new recording, choose Play New.
   - To listen to your original recording, choose Play Original.

4 If you like your new recording, click OK. Otherwise, click Cancel to delete the new recording and exit the Record window. (You can start over with step 1, if you want.)

Playing Back Sounds
When you open an image that has audio attached to it (indicated by a musical note), the audio clip automatically plays.
You can also select the image with sound and use the Audio buttons on the left side of your screen to listen to it:

3 Click and drag to select a section of the audio clip or the entire clip. You can perform the following operations:
   - Click the Play button to hear the section you selected.
   - Click Cut to remove the section.
   - Click Copy to copy it.
   - Select another image and click Paste to add the sound clip to the new image.

   **NOTE**
   To adjust recording or playback volume, or modify other features of your audio system, select System Properties from the Audio menu. You can also click (or right-click) the sound icon on your Windows task bar. Use the volume control on your speakers to quickly adjust playback volume.

**Deleting Sounds**
To delete an audio clip, follow these steps:

1 Select the image with the sound you want to delete.

---

**Editing Sounds**
You can modify your recorded sounds by cutting or copying and pasting from one clip to another. Follow these steps:

1 Select an image that has an audio clip.

2 Click the Edit Audio button, or choose Edit Audio from the Annotation menu. The sound wave window opens:

   - Click and drag to select a section of the audio clip or the entire clip. You can perform the following operations:
   - Click the Play button to hear the section you selected.
   - Click Cut to remove the section.
   - Click Copy to copy it.
   - Select another image and click Paste to add the sound clip to the new image.
Select **Delete Annotations** from the Edit menu. The following dialog box appears:

3. Click **Yes**.

**Adding Annotations (Windows Only)**

You can draw on your images to highlight specific areas or add special effects using the annotations feature. You can choose to have these annotations only show in Image Expert or be permanently blended into your picture.

Follow these steps to add annotations to your image:

1. Open the image you want to add the annotation to.
2. Click the **Ink** button.
3. Draw your highlights, signature, or other additions.
4. If you want to change the color or width of the lines, click the **Ink Options** button.
5. If you want to hide your annotations, click **Show Ink** in the View menu to deselect it.

4. Save your image and click **Yes** to save your ink changes.
The annotations don’t appear in other applications or in printed images. If you want the annotation to be a permanent part of your image, you can blend it in, as described in the section below.

**Blending In Annotations**

Once you blend an annotation into an image, you can’t change it back, so you may want to save a copy of your original image. Then follow these steps to permanently blend in your annotations:

1. Open the image that has the annotations that you want to make permanent.
2. Select **Blend Ink Into Image** from the Annotation menu.

   Image Expert displays the progress as the annotation is merged into your picture.

**Deleting Annotations**

If you have not blended the annotation into your image, you can delete it. Follow these steps to delete the annotation from your image:

1. Open the image that has the annotation that you want to delete.
2. Select **Delete Annotations** from the Edit menu.

   The following dialog box appears:

   ![Delete Annotations dialog box](image)

3. Click **Yes**.
Displaying Albums as Slide Shows

With Windows, when you display an album as a slide show, you can have it play automatically with various transition effects between images. Follow these steps:

1. Open your album.

2. Click the Slide Show button or select Slide Show from the View menu.

   The first image appears on your screen with the slide show controls, as shown:

3. Click the Play button to see the slide show.

4. If you want to change the appearance of your slide show, click the Options button. The Slide Show Options dialog box appears:

   - To stretch your pictures across the whole screen, click Fit to Screen.
   - To change the display period for each picture, change the number in the Seconds Between Pictures box.

5. Set any of the following options and click OK:
   - To play audio, select Play Sounds.
   - To show transition effects, select Show Transition Effects.
   - To show a link, select Show Link.

4-14 Working With Photos and Albums
To play the slide show only once, click Continuous Repeat to deselect it.

To hide the titles of your pictures, click Show Titles to deselect it.

To turn off the fades and dissolves that play between pictures, click Show Transition Effects to deselect it.

To turn off audio clips attached to your images, click Play Sounds to deselect it.

To hide ink annotations that appear on your images, click Show Ink to deselect it.

6 Click the Exit button to stop the slide show.

Using an Album as a Screen Saver

If you’re using Windows 95, Windows 98, or Windows NT, it’s easy to make your own screen saver with your favorite pictures. Follow these steps:

1 Open the album you want to use.

2 Choose Set Screen Saver from the File menu. Image Expert asks you to confirm your choice.

3 Click Yes.

Windows will play a slide show of your album whenever your system is idle.

NOTE
The screen saver slide show doesn’t include controls. If you want to change the way your pictures are displayed, you have to use the screen saver settings in your Control Panel. See your Windows documentation or Help system for more information.

Setting an Image as Wallpaper

You can use one of your own pictures as the background for your desktop. Follow these steps:

1 Open the image you want to use, or select it in an album.

2 Choose Set As Wallpaper (Set Desktop Picture for Macintosh) from the File menu.
For Macintosh, the image is set as the desktop background.

In Windows, the following dialog box appears.

3 Choose Center to place your picture in the middle of the screen or Tile to fill the screen with copies of your picture.

4 If you want the image to be stretched across the whole screen, click Resize to fit screen.

5 Click Yes. (If you change your mind, click Remove Wallpaper.)

You can minimize Image Expert to see your new wallpaper.

**Copying to Diskette or Zip™ Disk**

If you’re using Windows 95, Windows 98, or Windows NT 4.0, you can copy albums or individual images to diskettes or Zip disks. You can also include a player, so your friends and business associates can view your pictures on their computers. This makes your images and albums completely portable.

Follow these steps:

1 Insert a diskette into your diskette drive or a Zip disk into your Zip drive.

2 Open the album you want to copy.

   If you don’t want to include all of your images, select the images you want to add. To select more than one image, hold down the Ctrl or Shift key.

3 Select Save To Floppy from the File menu.
You see the following dialog box:

4 Make sure your diskette drive or Zip drive letter appears in the Copy images to box.

5 If you want to include a slide show player to view the pictures, make sure Include Slide Show Player is checked.

6 If you want to copy the whole album, make sure there is no check mark next to Selected Images Only.

NOTE
Depending on the size of your image files, you may be able to fit only two or three on a diskette. You may want to use Zip disks or other large-format storage media. Make sure your diskette (or other storage device) is not write-protected before you try to copy.

7 Click OK to copy your files.

Viewing the Pictures on Diskette or Zip Disk
To run the slide show, double-click the player icon or player.exe file. The pictures appear on your screen with the slide show controls, as shown below:

See page 4-14 for instructions on setting slide show options.
Sending Pictures and Sound by E-mail

You can send a picture directly from Image Expert if your e-mail application complies with the MAPI (messaging application programming interface) standard (Windows 95, Windows 98, or Windows NT 4.0 only). For example, you can use Inbox or Microsoft Exchange. You need to set up Microsoft Exchange to work with your Internet service.

NOTE
If you can’t e-mail pictures directly from Image Expert, you can always send an e-mail message as you do normally and attach one or more image and sound files.

Before you start, make sure your modem and Internet service are working correctly and your e-mail application is configured. Then follow these steps:

1. Select or open the image(s) you want to send. Some e-mail systems may limit the number of images you can send in a single message.

2. Choose Send from the file menu. You see the Choose Profile dialog box on the right.

3. Choose the profile you want to use.
Click New if your Internet service has not been set up to work with Microsoft Exchange. For more information about setting up Microsoft Exchange, see your Windows documentation or help system.

4. Click OK. Your e-mail application opens, and the image(s) you selected appear as attachments.

5. Type the e-mail address where you’re sending the picture(s). You can also type in a subject heading and message if you want.
6. When your e-mail is ready, click whatever button your application uses to send. The picture(s) are mailed.

Your e-mail application closes, and Image Expert becomes active again.
You can edit your images to enhance their appearance, crop, rotate, and resize them, or create special effects.

This chapter describes the following Image Expert features:

- Viewing and selecting images
- Applying Quick Fix
- Correcting an image
- Cropping an image
- Resizing an image
- Rotating and flipping an image
- Applying special effects
- Creating panoramas
- Changing the number of colors
5-2 Editing Images

Viewing and Selecting Images

When your image is displayed in an album, you can rotate it or do a quick fix. However, to use any other editing features, you need to open the image by double-clicking it or selecting Open Image from the File menu.

Before you edit your image, you may want to use the Zoom and selection tools on the left side of your screen.

- Click Zoom, and then click anywhere on your image to enlarge your view. Right click or hold down the control key and click to zoom out.
- Use one of the three selection tools (Select Rectangle, Select Ellipse, Select Freehand) to isolate a part of your image before you edit it. Click the tool, then click and drag on your image to select the portion you want to work on.
- Click Select All to select your entire image or all the images in an album.
- Click Select None to deselect your image or images.

NOTE
For more information about any of the editing tools described in this chapter, use the Help menu. For information on the Ink and Ink Options tools, see Chapter 4.
Applying Quick Fix

The easiest way to improve your image is to have Image Expert automatically “correct” it with the Quick Fix command. You can click the Quick Fix tool or select Quick Fix from the Image menu.

If you don’t like the results, simply select Undo Quick Fix from the Edit menu.

NOTE

If you Quick Fix an image displayed in an album (without opening it in the Image Expert window), you can’t undo it.

Correcting an Image

To fine-tune an image, click the Corrections tool or choose Corrections from the Image menu. You see a window like the following:
Click the tabs at the top of the screen to make these kinds of corrections:

- **Contrast and Brightness**
  For adjusting the amount of light in your image and the difference between light and dark areas.

- **Color**
  For correcting color casts and adjusting the balance of cyan (blue), magenta (red), and yellow; and red, green, and blue in your picture.

- **Hue/Saturation**
  For adjusting colors around the “color wheel,” the strength or purity of color, and the brightness of your image.

- **Sharpness**
  For emphasizing or de-emphasizing edges and details.

- **Equalization**
  For increasing and brightening detail in dark areas of your image.

Each dialog box “tab” includes sliders for quickly and easily correcting your image. Simply move the slide indicator left or right to make your edit.

The preview window shows your image with the original view on the left and the corrected image on the right. If you want to adjust the division between the original and edited image, click and drag the triangle below the image. You can also zoom in on your image to see more detail.

- Click **Apply** to make your changes on the current “tab.” Your edited image becomes your new original and the slide indicators move to the center of the range.
- Click **OK** to save the changes you made on all the Corrections tabs and return to the main screen.
- Click **Cancel** to cancel the changes on the current tab and return to the main screen.
**Cropping an Image**

If you want to save only part of your image, use the crop function to cut out the rest of the image. Follow these steps:

1. Open the image you want to modify.
2. Click one of the selection tools.
3. Click and drag the mouse over the area you want to save. A dashed border indicates the area you selected.
4. If you change your mind about which part of the image to crop, simply click anywhere outside the selected area of the image and repeat step 3.
5. Click the Crop tool or choose **Crop** from the Image menu. The part of the image that was outside the dashed line disappears.

**Resizing an Image**

You can resize your image by changing the number of pixels. This lets you maintain the image’s original resolution or pixels per inch.
Choose **Resize** from the Image menu. You see a dialog box like the following:

![Image Resize dialog box](image.png)

Type a new number for the width or height. To maintain your image’s proportions, both numbers change together. If you want to distort your image, click **Preserve Aspect Ratio** to deselect it.

### Rotating an Image

You can click the Rotate tool to quickly rotate a picture to the right. For more options, select **Rotate** from the Image menu.

**NOTE**

If you rotate an image displayed in an album (without opening it in the Image Expert window), you can’t undo it.

You can choose one of the following:

- **Left** (90 degrees counterclockwise)
- **Right** (90 degrees clockwise)
- **Exact** (specify the degree of rotation)
- **Free** (interactive rotation, as described below)

If you want to experiment with rotation, choose **Free** and follow these steps:

1. Click on your image and hold down the mouse. Your pointer turns into the rotation tool.
A rectangular outline of your image and an arrow appear, as shown:

2. Move the pointer to rotate your image.

3. Release the mouse when your picture is at the angle you want.

**Flipping an Image**

You can reverse your image by selecting Flip Horizontal from the Image menu. This is useful for printing T-shirt transfers. Select Flip Vertical to turn your image upside down.

**Applying Special Effects**

To transform or distort your images in interesting ways, choose Effects from the Image menu. You see a dialog box like the following:
Click the tabs at the top of the screen to add these effects:

- **Ripples**
  For an underwater effect. You can create whirlpool effects or just a slight distortion.

- **Glass blocks**
  You can change the number and size of the blocks.

- **Edges**
  To sharpen edges. You can also blend the image into a light or dark background.

- **Fisheye**
  To distort the center of the image, as if looking through a glass ball.

- **Invert**
  To create a negative of your image or to “solarize” it.

Each dialog box “tab” includes sliders for applying the effect. Slide the indicator to the right to increase the distortion. You can combine several filters for even more unusual effects.

The preview window shows your image with the original view on the left and the distorted image on the right. If you want to adjust the division between the original and filtered image, click and drag the triangle below the image. You can also zoom in on your image to see more detail.

- **Click Apply** to make your changes on the current “tab.” Your distorted image becomes your new original and the slide indicators move to the center of the range.

- **Click OK** to save the changes you made on all the Effects tabs and return to the main workspace.

- **Click Cancel** to cancel the changes on the current tab and return to the main workspace.

**Creating Panoramas**

You can use Image Expert to “stitch” individual photos into a 360° panorama. You can also create vertical stitches for tall objects.
Picture-Taking Tips
Use a tripod if possible. If you don’t have a tripod, take pictures by placing the camera on a flat surface or try keeping the camera level and near your face (use the viewfinder).

Take pictures in Super Fine mode for best results. Don’t use the digital panorama mode; this crops the top and bottom from the images.

Take pictures that overlap by about 50% to ensure that you get accurate detail in your final image.

Make sure the exposure for all your pictures is consistent. Slight differences can cause inconsistent coloring in the panorama.

Make sure you are at least 15 feet away from your subject and keep the zoom level the same for all images.

Take pictures of scenes that have a variety of detail and color. Scenes composed largely of one color or pattern produce poor results.

Slight differences can cause inconsistent coloring in the panorama.

See the Image Expert Quick Tour for some good examples of stitches and additional tips.

Stitching Images
Follow these steps to stitch your panoramic images:

1. Open the album that has the images you want to stitch.

2. Select Stitch from the Image menu.

3. Drag the pictures that you want to stitch together into the window, placing each where you want it to appear in the final image.
You can use any of the following options for your stitch:

- To remove an image, click the **Remove** button.
- For panoramas that are narrow to medium in width or tall, vertical images, click the **Perspective Projection** button.
- For wider panoramas, click the **Cylindrical Projection** button.
- For images that are aligned correctly but vary in brightness, click the **Smooth Blend** button.
- For images that are not lined up perfectly and need advanced blending, click the **Sharp Blend** button.
- Select an Output Size from the drop-down menu. (The larger the output size, the longer it takes to stitch.)

When you are finished setting up your panorama, click the **Stitch** button. You see the progress as your image is stitched.

When the stitch is complete, you see a screen with a crop rectangle around your stitched image.

If you want, adjust the cropping area by clicking outside the selected area and selecting a new area. When you have the area you want selected, click the crop button to crop your final image.

If you have problems with the results of your stitch, see the troubleshooting section below.

**Troubleshooting Panoramas**

Check the following problems and solutions if you are having trouble with your panoramas.

**Your final stitch is blurry.**

- Try using sharp blending for a sharper stitch.

**The exposure is inconsistent in the panorama.**

- Try using smooth blending.
Your image seems to have parts out of place.

- Check your arrangement on the grid. You may need to rearrange your images.

The images edges have a “bow-tie” effect.

- Try using cylindrical projection.

Images are not stitched together well.

- Make sure you have enough overlap between images (50% is recommended).
- Be careful that the camera does not move or tilt to different angles between shots.
- Try holding the camera right next to your eye, instead of away from you, or there may be too much camera movement.
- Take pictures of scenery that has enough detail. If there is not enough detail in the image (like a scene with a nondescript grassy field or plain blue sky) there may not be enough information to match up corresponding images.

- Make sure you are far enough from your subject. If you are less than 15 feet away from your subject, or if there are close objects in any of the images, the images will be stitched incorrectly.
- If there is movement in the scene, especially at a critical place of overlap, it may not be possible to determine how the photos should fit together.
- Make sure your zoom level is consistent for all the images. If any of the images in a scene have different zoom levels, the images can’t be stitched together.

There are overlap errors or ghost images.

- Try using sharp blending to remove some of these flaws.
- Remove any photos that don’t fit well with the others.

Stitching fails completely.

- A stitch may fail completely if the source images do not fit together correctly, the exposure varies drastically, or a fisheye lens (or other distorting lens) is used to take
pictures. If this happens, try taking a new set of pictures, making sure to follow all the picture-taking tips mentioned on page 5-9.

**Changing the Number of Colors**

To convert the color format of your image, select Number of Colors from the Image menu. You can choose from the following:

- **24 Bit (Millions of Colors)**
  The way your images are originally captured.

- **8 Bit (256 Colors)**
  For low-resolution display systems or certain types of software.

- **Grayscale (256 Shades of Gray)**
  For printing in black and white.

If you save your image as 8 Bit or Grayscale, you cannot switch back to 24 Bit color.

**NOTE**

*Unlike the other editing options, changing the number of colors applies to the whole image. You can’t change the number of colors for a selected area only.*
When the camera is connected to your computer, you can take pictures with a live preview on your computer screen to help you frame each shot. You can also set the camera’s clock and adjust a number of other settings from your computer. To change the power-saving mode (so your camera remains on after you take a picture with the LCD screen) and further customize your camera’s operation, you can use the Camera Settings menus on the LCD screen.

This chapter covers the following:

- Taking pictures from your computer
- Adjusting camera settings from your computer
- Customizing settings with the LCD screen

NOTE
You can use either Image Expert or EPSON Photo!2 to take pictures from your computer, adjust camera settings, and transfer images. PhotoPC 750Z allows you to choose the application that best meets your needs and preferences.

Taking Pictures From Your Computer With Image Expert

When you connect the camera and take pictures from your computer, you see a live preview of each shot before you capture it. You can control all the camera settings from your computer, and even set the shutter speed.
NOTE
If you have the optional AC adapter, you can save on batteries by using it when you connect the camera to your computer. The AC adapter should be available where you bought your PhotoPC 750Z, or you can order it from EPSON Accessories. See page A-1 for more information.

Follow these steps to take pictures from your computer:

1. Connect the camera to your computer as described in Getting Started.
2. Position the camera facing the subject. Using a tripod will give you the most control when setting up your shots. See page A-2 for instructions.
3. Turn on both your camera and your computer system.
4. Start Image Expert as described in Getting Started.
5. Click the Camera Controls button or choose Controls from the Camera menu.

You see a dialog box like the following:

---

NOTE
The camera's auto shut-off feature remains in effect when the camera is connected to your computer, but the camera shuts off after 5 minutes of inactivity. To turn the camera back on, close the lens cover and then open it again.
6 Click **Continuous Update** to activate the live preview feature. The image you see is updated every 8 to 10 seconds, depending on your connection speed. You may need to move the camera or your subject until you see the image you want to capture.

The colors in your live preview image may appear pale and washed-out. This will not affect the colors in your actual photograph.

You can click the **Flash** and **Resolution** buttons on the screen to adjust these settings just as you would by using the buttons on the camera. For more information, see Chapter 1.

**NOTE**

When the camera is connected to your computer, you can’t use any of the control buttons or the shutter button on the camera. You can operate these features only through your computer.

7 When your shot is ready, click **Take Picture**. The image is captured and processed.

8 Click **Close** when you’re finished taking pictures from your computer.

**NOTE**

The live preview feature quickly drains your batteries. Make sure you turn it off as soon as you’re finished, or use the optional AC adapter.

**Using the Self Timer**

You can use this feature to have your computer take a picture automatically, after a delay period that you can set. This allows you to take self-portraits and other specialized shots.
Follow these steps:

1. Click **Self Timer**. You see the following dialog box:

   ![Self Timer dialog box](image)

   - **Take Picture After**: Enter a number for the delay period you want to use. You can set up to a 120-second delay.
   - **Start/Stop**: Click to start the countdown and take the picture. The red timer light on the camera remains on for the delay period you entered. Then the light flashes rapidly for 2 seconds and the shutter is released.

   The camera beeps and processes your picture.

### Setting the Shutter Speed

Most of the time, PhotoPC 750Z adjusts the shutter speed automatically. However, when you take pictures from your computer, you can adjust the speed manually. This lets you use special lighting effects and even take “stop-action” photos.

On the Camera Controls window, click the arrow and select the speed you want from the drop-down list. When you change the speed, Image Expert remembers what you chose the next time you connect the camera.

### Taking Pictures With EPSON Photo!2

You can use your EPSON Photo!2 application to take pictures from your computer, in the same way as Image Expert.

First, follow steps 1 through 3 on page 6-2. Then follow these steps:

1. Start EPSON Photo!2 as described on page 3-3.
2. Click the **Controls** tab. You see a dialog box like the following:

![Dialog Box](image)

You can click the **Mode**, **Flash**, **Self Timer**, and **Macro** buttons on the screen to adjust these settings just as you would by using the buttons on the camera. For more information, see Chapter 1 and *Getting Started*.

4. When your shot is ready, click **Take a Picture**. The image is captured and processed.

5. Click **Close** when you're finished taking pictures from your computer.

The Auto-Stop Timer shuts off live preview after one minute to save battery power. You can set the timer from 30 seconds to 5 minutes.

3. Click **Start** to display the live preview.

The colors in your live preview image may appear pale and washed-out. This will not affect the colors in your actual photograph.
6-6 Using Custom and Advanced Features

Adjusting Camera Settings From Your Computer

You can use either Image Expert or EPSON Photo!2 to change the following camera settings:

- Time
- Date
- Power down time (Auto Shutoff)
- Camera ID
- Connection Port
- Connection Speed

Changing Settings With Image Expert

In Image Expert, you can change settings when you are viewing pictures in the camera. Follow these steps:

1. Connect the camera to your computer as described in Getting Started.
2. Turn on both your camera and your computer system.
3. Start Image Expert as described in Getting Started and click the View Images button.
4. Click the Camera Properties button to display the Camera Properties dialog box, as shown below:

   ![Camera Properties Dialog Box]

   - Enter a new Description to change the default. This might be useful if you have more than one camera and you want to record its Description in your picture data.
Type in the **Computer Time** and **Camera Time** boxes to change the time and date of either one. Or, click **Set Camera to Computer Time** to automatically synchronize your camera to your computer.

You can check the Camera ID and Firmware version in the Manufacturer Information.

5 Click **OK** to return to the View Images window.

6 If you want to adjust your port settings, click the **Camera Connection** button. You see the Connection dialog box:

- Select another port if you want to change your connection. In most cases, it is best to leave the **Port** setting at **Auto** because Image Expert can detect the camera connection automatically.

- Select a different communication speed. Image Expert automatically chooses the fastest speed that works with your system. This may actually be too fast for the configuration of your port. You may need to experiment to choose the best speed. (See your Windows Help or Documentation to change the port speed for your computer.)

7 Click **OK** to return to the View Images window.
Changing Settings With EPSON Photo!2
When you’re using your camera with EPSON Photo!2, you can click the Setup tab to display the following dialog box:

You can change the Computer Connection settings as described on the following page and then click the Test Connection button.

- Select another port if you want to change your connection. In most cases, it is best to leave the Port setting at Auto because EPSON Photo!2 can detect the camera connection automatically.
- Select a different communication speed. EPSON Photo!2 automatically chooses the fastest speed that works with your system. This may actually be too fast for the configuration of your port. You may need to experiment to choose the best speed.
- Click Test Connection to make sure your new settings work with your system.
- Click the Set Time button to change the camera’s time and date settings.

You see a dialog box like the following:
Enter new values for the settings, or click Copy from Computer to have your camera automatically synchronized to your computer. Click OK to return to the Setup dialog box.

- Enter a new Auto Shut-off Time if you want to change this setting (not available on Macintosh). This is the idle period after which the camera turns off automatically when it is not connected to your computer. (If you set a power-down time in Image Expert, it overrides the auto shut-off time setting in EPSON PhotoFrame.)

- Enter a new Camera ID if you want to change the default. This might be useful if you have more than one camera and you want to be able to have its ID recorded in your picture data.

Customizing Settings With the LCD Screen

In addition to using your computer to customize camera settings, you can use the LCD screen Settings menu. This lets you change the power mode so your camera remains on after you capture a picture with the LCD screen. You can also set the camera’s date and time, turn the alert beep off, and adjust the LCD brightness level.

Follow these steps to access the Settings menu:

1. Rotate the camera dial to Play or View.
2. Press the SEL button to display the LCD screen menus.
3. Press the < or > button until you see the Settings menu:

   ![Settings Menu](image)

   **Using Custom and Advanced Features 6-9**
4 Follow the instructions below for the settings you want to change.

5 When you’re finished adjusting settings, press the ESC button to return to normal playback mode.

**Setting the Camera Clock**
Follow these steps to set the date (year, month, day) and the time (hour and minute).

1 With the Settings menu selected, press the SEL button. Icons for each setting appear on the screen, with the clock icon highlighted in orange:

2 Press SEL to enter the clock setting mode.

3 Press SEL again to choose the portion of the time or date you want to adjust. The selected item turns red.

4 Press the ◢▼ button to increase the number, or the ◄▲ button to decrease the number, until the item you want to adjust is correct. Then press SEL to move to the next item (or ESC to move to the previous).

5 Repeat steps 3 and 4 until the date and time are correctly adjusted and saved. Press the SEL button again to return to the Camera Settings menu.

**NOTE**
You need to reset the time and date whenever you replace the camera’s batteries. In this case, you can enter the clock setting mode directly rather than going through the Camera Settings menu. See Getting Started for instructions.
**Setting the Alert Beep**

The camera’s alert beep lets you know when an image has been captured. To turn the beep on or off, follow these steps:

1. With the Settings menu selected, press the SEL button. Icons for each setting appear on the screen:

![Settings Menu](image)

2. Press the ▲/▼ button to select the beep setting icon 🎧.

3. Press the SEL button again. Press the ▲/▼ or ▼/▲ buttons to adjust the screen brightness.

4. Press the ESC button to save your setting and return to the Settings menu.

**Setting the LCD Brightness**

To adjust the brightness of the screen, follow these steps:

1. With the Settings menu selected, press the SEL button. Icons for each setting appear on the screen, as shown on page 6-11.

2. Press the ▲/▼ button until the brightness icon 🎈 is highlighted in orange.

3. Press the SEL button again.

4. Press the ▲/▼ or ▼/▲ buttons to adjust the screen brightness.

5. When you're finished adjusting the screen brightness, press the SEL or ESC button to save your setting and return to the Settings menu.
Setting the Power Mode

Your camera is set at the factory to the “Normal” power mode. This means that the camera remains on after you take a picture with the LCD screen. You can change the power setting to “Save” if you want the camera to shut off automatically after you take a picture with the screen. Follow these steps:

1. With the Settings menu selected, press the SEL button. Icons for each setting appear on the screen, as shown on page 6-11.
   Press the ►/▼ button until the power icon □ is highlighted.

2. Press the SEL button to choose Save or Norm.

3. Press the ESC button to save your setting and return to View or Playback mode.

Setting the Language

You can choose from two languages for information displayed on the LCD screen. Make sure the camera dial is turned to Play and follow these steps to select English:

1. Press the SEL button to display the LCD screen menus.

2. Press the◄/▲ or ►/▼ button until you see the Language menu:

   ![Language Menu]

3. Press the SEL button until ENG (English) is highlighted.

4. Press the ESC button to save your selection.

5. Turn the camera dial to Off.
Using Your Camera for Presentations

You can connect your camera to a multimedia projector or television and show not just photos, but also text and graphics. The EPSON Photo File Uploader lets you transfer images from your computer to your camera. Anything you can display on your computer screen can be captured, converted, and uploaded. You can create and show a presentation without printing overhead transparencies or slides, and without a laptop computer.

This chapter explains the entire process, including the following:

- Uploading images to the camera
- Converting presentations
- Projecting your presentation

Uploading Images to the Camera

The EPSON Photo File Uploader software allows you to convert any image or presentation slide to the EPSON Photo file format and upload it to your camera or a CompactFlash storage card in your computer’s PCMCIA drive.

You can upload images in 640 × 480 pixel, 1280 × 960 pixel, or 1280 × 480 pixel sizes. EPSON Photo File Uploader automatically converts images from their original size to whichever of these sizes you choose.

NOTE
Images that have been cropped will display black strips in the areas that have been cropped out.
Uploading Existing Images From Your Windows PC

Before you start, make sure the camera is connected to your computer, and the computer is on and the camera dial is turned to Play. Then follow these steps:

1. Start the EPSON Photo File Uploader program. In Windows 95 or Windows 98, click Start, and then point to Programs, PhotoPC 750Z, Photo File Uploader. You see a screen like the one on the right.

2. Use the Drive and Folder lists to locate the folder containing the images you want to upload. Double-click the folder to select it.

The images in the folder are listed in the File Name box.

NOTE
If you want to upload images from a network drive, you may need to map the drive before opening the EPSON Photo File Uploader software. See your Windows Help utility or documentation for more information.
3 Select the format of the images you want to upload from the File Type list.

4 Select the images you want to upload in the File Name list. Then click the → button. If you want to upload all the images in the list at once, click the >> button.

As you select files, they appear in the Selected Files List in the order they will be uploaded, as shown on the right. This determines the sequence in which you can display the images.

- To rearrange the uploading (and display) order, select the image you want to reorder, then click the ↑ or ↓ sort arrow.
- If you want to change your selection, click the <- button to remove selected files or click the << button to remove all the files from the Selected Files List.
- If you want to preview a selected image and confirm its size, click the Preview checkbox.

5 For each file in the Selected Files List, choose an image size from the Image Size box. The File Uploader resizes your files during the transfer process.

If you want to save copies of the converted files on your computer, click the Save file to checkbox. Click Browse, then select the folder where you want to save the files. Click OK. The folder you selected is displayed to the right of the Browse button.
6 Click the Select Camera button, choose your camera, and click Select.

7 Click Start to start uploading the images. EPSON Photo!2 opens and displays the images you selected:

8 Click Select All to select all the images, or select individual images by clicking the thumbnails in the image selection window.

9 Click Upload/Copy.

The Upload Photos dialog box appears:

10 Click Upload into the Camera to upload the images to your camera, or click Copy to a Compact Flash Memory Card to upload to a storage card installed in your computer’s PCMCIA drive; then click OK. The images are uploaded to the destination you selected.

7-4 Using Your Camera for Presentations
The images are uploaded to the destination you selected. If you clicked the Save file to checkbox in step 5, the converted images are also saved to the folder you specified.

**Uploading Images From Your Macintosh**

Follow these steps to upload images to your camera from your Macintosh:

1. Make sure the camera is connected to the computer, and that the computer is turned on and the camera dial is turned to Play.

2. Double-click the EPSON Photo File Uploader icon. The EPSON Photo File Uploader window opens, as shown on the right.

3. Click Add. The Select Files dialog box appears.

4. Double-click the folder containing the images you want to upload, then select each file you want to upload and click Select.

If you want to preview a selected image and confirm its size, click the Preview checkbox. It takes a few seconds longer to select images with previews displayed.
5 When you finish selecting image files, click Done to close the Select Files dialog box. The selected images appear in the Selected File List in the order they will be uploaded. This determines the sequence in which you can display the images.

• To rearrange the uploading order, select the image you want to reorder, then click Up or Down.
• To remove files from this list, select the file(s) and click Remove.

6 For each file in the Selected File List, select an image size from the Image Size box. The File Uploader will resize your files during the transfer process.

If you want to save copies of the converted files on your computer, click the Save file to checkbox before uploading the photos. Click Browse, then select the folder where you want to save the files. Click OK. The folder you selected is displayed to the right of the Browse button.

7 Click the Select Camera button, choose your camera, and click Select.

8 Click Upload. A window opens to show you the progress of the file conversion. Then EPSON Photo!2 opens and displays the images you selected:

9 Click Select All to select all the images, or select individual images by clicking the thumbnails in the image selection window.
10 Click **Upload**. The Upload/Copy Photos dialog box appears.

11 Click **Camera** to upload the images to your camera, or click **CompactFlash Memory Card** to upload to a CompactFlash storage card installed in the PCMCIA drive of your Macintosh; then click **OK**. The images are uploaded to the destination you selected.

If you clicked **Save file to** in step 5, the converted images are also saved to the folder you specified.

---

**Converting Presentations**

If you want to upload a presentation or document that is not saved as a standard image file, you can make a “screen capture” of your computer desktop with the file open. This lets you turn any document or presentation into a series of image files that you can convert and upload to the camera or to a storage card.

**NOTE**

If you want to upload a PowerPoint presentation, you don’t need to use this conversion procedure. You can save the slides as JPG files in PowerPoint, and then upload them into the camera. Choose **Save As** from the PowerPoint File menu and choose **JPEG File Interchange Format** as the file type.

Windows users can make screen captures from within the EPSON Photo File Uploader utility; Macintosh users need to use the standard Macintosh screen capture function.
Capturing Windows Screens

Before you start, make sure the camera is connected to your computer, and the computer is turned on and the camera dial is turned to Play. Then follow these steps:

1. Start the EPSON Photo File Uploader program as described on page 7-2. You see the EPSON Photo File Uploader window, as shown on page 7-2.

2. Click the Screen Capture tab. The Screen Capture dialog box appears, as shown on the right.

3. Use the Drive and Folder lists to select the folder where you want to save the screen capture. To create a new folder for the images, click the New Folder button.

4. Specify the key combination you want to use for screen captures in the Hot Key setting box. Click the ALT, CTRL, or SHIFT checkbox, then select a function key from the hot key list. The default hot key is F5.

Set key combination to use for capturing screens.

Set the drive and folder for saving screen captures.

7-8 Using Your Camera for Presentations
5 Click **Start** to activate the key combination. When the key combination is activated, the **Start** button changes to a **Stop** button. The key combination remains active only for the current session. To deactivate the hot key combination, press the **Stop** button.

6 Start your application and open the file to the page or image you want to capture.

---

**NOTE**
The entire screen is captured, not just the active window. Make sure you maximize your presentation before you capture it. If you set your application to “slide show” mode (or the equivalent) you can capture just the image you want, without menus and other screen elements.

7 Press the hot key combination you selected.

You can make as many screen captures as you’d like; simply open each file you want to capture and press your screen capture key combination again.

---

8 When you’re finished, close your application and click the **Stop** button on the Screen Capture dialog box. The key combination you selected is erased.

If you want to upload your screen captures to the camera right away, click the **Upload To Camera** tab. The screen capture files appear in the **File Name** list. Then follow the uploading instructions starting with step 4 on page 7-3.

---

**TIP**
Presentations using large fonts (at least 18 point) work best.

---

**Capturing Macintosh Screens**
EPSON Photo File Uploader for the Macintosh does not have a screen capture feature. However, you can make screen captures using your Macintosh system software, then use EPSON Photo File Uploader to upload the screen captures to your camera.

The procedure may be different depending on your Macintosh. See your computer manual for instructions on making screen captures.

---

**Using Your Camera for Presentations  7-9**
Make sure the camera is connected to your Macintosh, the computer is turned on, and the camera dial is turned to Play. Then follow these steps:

1. Open the EPSON Photo File Uploader as described on page 7-8.

2. Start your application and open the file to the image you want to capture.

   **NOTE**
   The entire desktop is captured, not just the active window. Make sure you make your document window as large as possible before you capture it. If you set your application to “slide show” mode (or the equivalent), you can capture just the image you want, without menus and other screen elements.

3. Press the Command, Shift, and 3 keys on your computer keyboard at the same time. Your Macintosh names and saves the screen shot on your hard drive (not in a folder).

   You can make as many screen shots as you’d like; simply repeat this step.

4. When you are finished, close your application.

To upload your screen shots to the camera, click the EPSON Photo File Uploader window to make it active, then follow the uploading instructions starting with step 3 on page 7-5.

### Projecting Your Presentation

You can display the uploaded images on a multimedia projector, television, or other video output device. Use the video cable that came with your PhotoPC 750Z.

   **NOTE**
   Using the optional AC adapter is highly recommended when you project your presentation. See pages A-1 and A-2 for instructions and ordering information.
Follow these steps:

1. Make sure your camera and TV or video projector are turned off.

2. Open the camera’s connector cover and connect the black end of the video cable to the Video Out port, as shown below:

3. Connect the yellow end of the video cable to the VIDEO IN port on the TV or projector as shown on the right.

4. Turn on the TV or video projector and switch it to video mode.

5. Turn the camera dial to Play.

The last image that you uploaded into the camera is projected. If you are using the optional AC adapter, you can also see the image on the LCD screen.

You can use the camera’s slide show feature to play your images automatically, or play them one at a time using the navigation buttons. You can use all of the camera’s other playback features to show your presentation.
Using CompactFlash Memory Cards

Your 8MB ATA-compatible CompactFlash card increases the storage capacity of your PhotoPC 750Z camera. You can use additional cards to take pictures and copy photos from and to your camera.

It’s easy to install and remove memory cards from your camera. You can use an optional IOMEGA Clik! drive to access images directly from your card. Or, if your desktop or notebook computer has a Type II PCMCIA card slot, you can access images directly by using an optional PCMCIA adapter. Additional CompactFlash memory cards, drives, and adapters should be available where you bought your PhotoPC 750Z camera.

NOTE
When you install a memory card, the camera stores and displays pictures on the card, rather than in its internal memory. When you remove the card, the camera uses its internal memory.

EPSON recommends ATA-compatible CompactFlash cards from the following manufacturers:

- Lexar Media, (800) 789-9418
- SanDisk, (408) 542-0595

This chapter covers the following:

- Installing a memory card
- Formatting a memory card
- Removing a memory card
Installing a Memory Card

Before you start, make sure the camera is turned off. Then follow these steps:

1. Lift open the memory card cover and insert the card all the way into the slot, as shown below.

2. Close the memory card cover.

The number of pictures you can store in the memory card appears in brackets on the camera’s display panel.

8-2 Using CompactFlash Memory Cards

Getting images from a card to your computer
Getting memory information
Copying to and from a memory card

Your 8MB CompactFlash card increases the camera’s picture storage capacity as shown in the table below.

Number of pictures (average)

<table>
<thead>
<tr>
<th>Image quality</th>
<th>Internal memory</th>
<th>8MB card</th>
<th>12MB (internal memory + card)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>50</td>
<td>128</td>
<td>178</td>
</tr>
<tr>
<td>Fine</td>
<td>15</td>
<td>39</td>
<td>54</td>
</tr>
<tr>
<td>Super Fine</td>
<td>7</td>
<td>19</td>
<td>26</td>
</tr>
<tr>
<td>HyPict</td>
<td>4</td>
<td>12</td>
<td>16</td>
</tr>
</tbody>
</table>

NOTE
When a memory card is installed, you may notice a delay between the time you press the shutter button and when the camera beeps. To avoid blurring of images, make sure you hold the camera still until it beeps.
Formatting a Memory Card

Most ATA CompactFlash cards are already formatted when you buy them. However, to ensure proper formatting, always format new cards before using them.

With the memory card installed in the camera, follow these steps:

1. Set the camera dial to Play. If you haven’t used the memory card, you may see the following message:

   **Note**
   
   No photos in memory.

   This applies to the memory card only, and does not indicate whether you have photos in the camera’s internal memory.

2. Press the SEL button to display the LCD screen menus.

3. Press the \(<\) or \(>)\ button until you see the Photo Control menu. Then press the SEL button to display the menu options, as shown below:

   ![Photo Control Menu]

4. Press the \(<\) or \(>)\ button until Format Card is highlighted.

5. Press the SEL button. A message appears stating that all data on the card will be erased and asking you to confirm the procedure.

6. Press the SEL button again to format the card and return to the Photo Control menu.

7. Press ESC until you return to normal playback mode.
NOTE
If you have problems formatting or using a memory card, try the following technical support numbers:

- Lexar Media: (510) 413-1200
- SanDisk: (408) 542-0400

Removing a Memory Card
Make sure the camera is turned off. Then follow these steps:

1. Lift the cover open and press the Eject button on the bottom of the camera to eject the card, as shown below.

2. Remove the card by hand, then close the memory card cover.

CAUTION
Never remove the card while the camera is accessing it. Data in the card may be lost or damaged. Avoid using or storing the card in dusty places, in direct sunlight, or in places that become extremely hot or humid.

Getting Images From a Card to Your Computer
A PCMCIA adapter allows you to access images stored on CompactFlash cards directly from your computer or notebook/PowerBook. To use this adapter, your computer must be equipped with a Type II PCMCIA card slot.

If you’re using a Macintosh, you must enable the PC Exchange extension software to access files on CompactFlash cards. See your Macintosh documentation for information.
NOTE
If you don’t have a PCMCIA adapter, you can simply leave the card in your camera and transfer the images to your computer following the instructions in Chapter 4.

Using a PCMCIA Adapter
Follow these steps to use an adapter:

1. Insert the memory card all the way into the adapter:

2. Insert the adapter into your computer’s Type II PCMCIA slot:

Transferring Photos
Once the adapter and card are installed in your computer’s PCMCIA slot, you can transfer photos by simply copying them to your hard drive. This is the fastest way to get pictures into your computer. The image files are stored in the Photo_1 folder on the card.

- In Windows 95, Windows 98, or Windows NT 4.0, use My Computer or the Windows Explorer to drag and drop image files to your hard drive.
In Windows NT 3.51, use the Windows File Manager to copy image files to your hard drive.

On a Macintosh, use the Finder to drag and drop image files to your desktop or hard drive.

Click the **View PC Card Images** button in Image Expert and follow the instructions in the *Getting Started* guide to transfer images in the usual way.

**NOTE** If you can’t access a card in your notebook computer, contact the computer manufacturer. For more information, see page 10-7.

### Getting Memory Information

You can use the Photo Control menu to get information on the number of pictures taken and remaining in your camera’s internal memory and on an installed memory card. Make sure the camera dial is set to **Play** and follow these steps:

1. Press the SEL button to display the LCD screen menus.
2. Press the ◀/▶ or ▼/▲ button until you see the Photo Control menu.
3. Press the SEL button to display the menu options:

   ![Photo Control Menu]

4. Press the ▼/▲ button until *Photo Info* is highlighted in orange, then press the SEL button. You see information displayed like the following:

   ![Photo Info]

   - number of photos stored in camera or card
   - number of photos you can store at current image quality

---

**8-6 Using CompactFlash Memory Cards**
Copying To and From a Memory Card

When a memory card is installed in your camera, you can copy photos between the camera’s internal memory and the memory card. Before you start, make sure the camera dial is set to Play. You might find it easier to select images if you set the playback mode to Multi. See page 2-4 for instructions. Then follow these steps:

1. Press the SEL button to display the LCD screen menus.
2. Press the ▼ or ► button until you see the Photo Control menu. Then press the SEL button to display the menu options:

<table>
<thead>
<tr>
<th>Erase</th>
<th>Photo Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock</td>
<td>Copy</td>
</tr>
<tr>
<td>Format Card</td>
<td></td>
</tr>
</tbody>
</table>

3. Press the ▼ or ► button until Copy is highlighted in orange, then press the SEL button to enter the Copy mode. The following menu is displayed:

   | Camera→Card |
   | Card→Camera |

4. Press the ▼ or ► button to copy photos from the camera to the card, or from the card to the camera.

5. Press ESC to return to the Photo Control menu. Continue pressing ESC to return to normal playback mode.
5 Press the SEL button, then press the ◀/⬆ or ▶/▼ button to move forward or back through the images in the camera until the photo you want to copy appears on the screen.

6 Press the SEL button. An orange frame appears around the photo. If you want to copy several photos at the same time, use the ◀/⬆ or ▶/▼ button to display them and press the SEL button each time.

**NOTE**
To cancel the selection of a photo, simply press the SEL button again. If you select more photos than the card or camera can hold, an error message appears.

7 When you have selected all the photos you want to copy, press the ESC button. A message appears asking you to confirm your selections.

8 Press the SEL button to copy the images.

9 Press ESC until you return to playback mode.
Your PhotoPC 750Z camera lets you print your pictures directly to any of several EPSON ink jet printers, without using a computer. You can choose from a number of layout options and print in four different color modes.

You can print directly from the camera to any of the following printers:

- EPSON Stylus® Photo
- EPSON Stylus Photo 700
- EPSON Stylus Photo EX
- EPSON Stylus COLOR 600
- EPSON Stylus COLOR 800
- EPSON Stylus COLOR 850
- EPSON Stylus COLOR 740

**NOTE**

Using the optional AC adapter is highly recommended when you’re printing from the camera. The adapter should be available where you bought your camera. Or, see page A-1 for information on ordering an adapter from EPSON Accessories.

This chapter includes the following information:

- Uploading Direct Print
- Connecting the camera to the printer
- Starting Direct Print
- Printing
- Cleaning the print heads
- Removing Direct Print
- Error messages
NOTE
The Direct Print program is designed to work with special ink jet media, including coated or glossy paper, glossy film, ink jet cards, and photo stickers. If you use plain paper, your pictures will not be printed at the highest quality. See your printer User’s Guide for more information about special paper and film available from EPSON, or visit our website at www.epsonsupplies.com.

Uploading Direct Print
To use Direct Print, you must first copy the program into your camera with the Program Uploader in the PhotoPC 750Z folder.

If you have an AC adapter, connect that first, then connect the camera to your PC or Macintosh. (If you need instructions, see page A-2 for connecting the adapter and Chapter 4 for connecting the camera to your computer.)

Then turn on your computer and the camera and follow these steps:

1. Make sure the camera is connected to your AC adapter and to your computer, and the camera and computer are turned on.

2. In Windows 95, Windows 98, or Windows NT 4.0, click Start, point to Programs, then PhotoPC 750Z, and click EPSON Program Uploader.

   In Windows NT 3.51, double-click the PhotoPC 750Z icon to open the group, and then double-click the Photo Program Uploader icon.

   On a Macintosh, first make sure AppleTalk is inactive. Then double-click the PhotoPC 750Z folder, EPSON Photo!2 folder, and the EPSON Program Uploader icon.
You see the EPSON Program Uploader window:

The Direct Print programs appear in the Applications in Folder list on the left.

3 Highlight the version of Direct Print for your printer:

- **Direct Print V2.2**: EPSON Stylus COLOR 600, EPSON Stylus COLOR 800, EPSON Stylus COLOR 850
- **Direct Print V2.3**: EPSON Stylus Photo, EPSON Stylus Photo EX, EPSON Stylus Photo 700, EPSON Stylus COLOR 740

Note: EPSON Stylus Photo, EPSON Stylus Photo EX, and EPSON Stylus Photo 700 support both versions of Direct Print.

4 Click the Upload button. The Uploader copies the program to your camera. When the program has been installed, you see Direct Print V2.2 or Direct Print V2.3 in the Applications in Camera list on the right.

5 Click Close to exit the program.

6 Turn off your camera and disconnect it from the computer.

Now you can connect your camera to the printer and start using Direct Print.
Connecting the Camera to the Printer

Before you start, make sure you have the Macintosh connection/Direct Print cable that came with your camera (or a standard Apple System Serial-8 printer cable). Don’t use the PC connection cable.

Follow these steps to connect your camera to the printer:

1. Make sure both the camera and printer are turned off.

2. Connect either end of the interface cable to the serial connector on the back of the printer.

3. Open the connector cover on the side of the camera.
4 Line up the arrow on the cable connector with the mark on the camera’s serial port, then insert the connector.

Starting Direct Print
Follow these steps to start Direct Print:

1 Turn on the printer.
2 Turn the camera dial to Play.
3 Press the SEL button.

4 Press the ◄/↑ or ►/↓ button until you see the Software Menu.

5 Press the SEL button.

6 Press the ►/↓ button to highlight Direct Print and press the SEL button. You see the Print menu:

![Print menu]

NOTE
You can press the ESC button to return to the previous screen at any time while using Direct Print.
Printing
You can print any selected image(s) or all the images in your camera on various types of paper. The following sections describe printing with the available layout options:

- Printing a full size or 5 × 7 image
- Printing a card
- Printing album images
- Printing stickers
- Making an index print

Printing a Full Size or 5 × 7 Image
These layouts allow you to print one image per sheet of paper. The Full Size option prints at the largest size that will fit on the page. The 5 × 7 layout prints an image that is 5 × 7 inches.

These pictures show the way the printout appears on the paper you select for a full size image:

These pictures show the way the printout appears on the paper you select for a 5 × 7 image:
Load your paper in the printer following the instructions in your printer User's Guide, then follow these steps to print a full size or 5 x 7 image:

1. On the Print menu (shown on page 9-5), press the >/v button to highlight Layout and press the SEL button.

   You see the Layout menu:

   ![Layout Menu](image)

   - Full Size
   - 5 x 7 Size
   - Card
   - Album
   - Sticker
   - Index

2. Highlight Full Size or 5 x 7 Size and press the SEL button.

3. Press the >/v button to highlight Photo and press SEL. You see the Photo screen:

   To print all the photos in the camera, highlight All and press SEL. Then go to step 6 on page 9-8.

   To select photos to print, highlight Select and press the SEL button. You see thumbnail versions of the pictures in the camera (up to nine at once), with the currently selected image highlighted by a light blue border.

4. Press the </a or >/v button to highlight the picture you want to print. When you see the light blue border around the image, press the SEL button.

   ![Photo Screen](image)
Repeat this step for as many images as you want to print. When you move the highlight to other images, you can see a dark blue border around any image you have selected. To deselect an image, highlight it and press the SEL button. The dark blue border disappears.

5 When you are done selecting images, press the ESC button. You see a message like the following:

```
Confirmation
1 photo Selected.
Done : SEL. Cancel : ESC
```

Press the SEL button (if you want to keep what you have selected). If you want to go back and select different photos, press the ESC button.

NOTE
If you go back to select different photos, all your selections disappear and you have to start over again. If you don’t select anything, the Photo option is set back to All.

6 Press the ← or → button to highlight the Paper option and press the SEL button. You see the first paper menu (paper size):

```
Paper
A4
Letter
A6
Photo Paper
```

For Full Size, you can select A6 (105 x 148 mm), Photo Paper (4 x 6 inches), Letter, or A4. For 5 x 7, you can select Letter or A4. Press the ← or → button to highlight the correct size.

9-8 Printing Directly From the Camera
7 Press the SEL button to go to the next paper menu (if you selected Photo Paper, you return to the Print menu with Glossy Paper automatically selected):

You see the Copies menu:

```
Num. of copies
1 copy
```

Press the ▼/a button to increase or ▶/v button to decrease the number of copies and press the SEL button to return to the Print menu.

8 If you want to print more than one copy of each photo, press the ▼/a or ▶/v button to highlight the copies option and press the SEL button.

9 Press the ▶/v button to highlight the Time option and press the SEL button. The Time setting lets you print the picture with the time and date the photo was taken. Highlight either On or Off and press the SEL button to return to the Print menu.

---

**NOTE**
The Time option is not available when you are printing with Photo Paper selected as your paper option.

---

*Printing Directly From the Camera* 9-9
Press the ▲/▼ button to highlight the **Color** option and press the SEL button. You see the Print Color menu:

<table>
<thead>
<tr>
<th>Print Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Monochrome</td>
</tr>
<tr>
<td>Blue</td>
</tr>
<tr>
<td>Sepia</td>
</tr>
</tbody>
</table>

Choose **Color** to print the picture in full color, **Monochrome** to print it in black and white, **Blue** to print it in blue tones, or **Sepia** to print it in brown tones for an old-fashioned look. Highlight the setting you want and press the SEL button.

Press the ▲/▼ button to highlight the **Mode** option and press the SEL button. You see the Mode menu:

<table>
<thead>
<tr>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast</td>
</tr>
<tr>
<td>Fine</td>
</tr>
</tbody>
</table>

For a quicker, lower-resolution printout, highlight **Fast**. Or, for a higher-resolution, slower printout, highlight **Fine**. Then press the SEL button to return to the Print menu.

---

9-10  Printing Directly From the Camera
Producing Your Printout

When you’re ready to print your picture, first make sure you have the correct paper or film loaded in the printer. (See your printer’s User’s Guide for paper loading instructions.) Then follow these steps:

1. Highlight Print at the top of the Print menu and press the SEL button. You see a confirmation screen telling you how many photos are selected.

2. Press the SEL button to continue printing or press ESC to return to the Print menu. The LCD screen goes blank and the display panel shows a star flashing across it while the picture is being sent to the printer. Then the printer starts printing the picture.

NOTE

If you want to stop printing a picture, hold down the ESC button for about 3 seconds. You see a message on the LCD screen that the printing is canceled, and then the Print menu reappears. The printer stops printing and ejects the paper.

3. When you’re finished printing your picture(s), press the ESC button several times to exit the Direct Print program. Turn the camera dial to OFF and turn off the printer.

Printing a Card

This layout allows you to print a single 3.25 × 4.25-inch image on an A6-sized card (approximately 4 × 6 inches). EPSON Photo Quality Ink Jet cards are perfect for snapshots, photo greeting cards, and many other uses. You can also use this layout with A6-size glossy film.

These pictures show the way your printouts appear:
This section provides an overview of how to print cards. See the previous section for detailed instructions on using most of the menus. Load your card(s) in the printer, then follow these steps to print:

1. From the Print menu, select Layout and then select Card. (See page 9-7.)

2. Go to the Photo menu and select All to print all your photos, or select which photos you want to print. (See page 9-7.)

3. Go to the Paper menu and select the correct paper type. (See page 9-8.) The paper size is automatically set to A6.

4. Press the ▼/ button to highlight Posi. (position) and press the SEL button. You see the Position screen:

   The Position setting lets you select the position on the card where the image is printed. Highlight Top, Center, Bottom or Full Size. Full Size prints the maximum area (3.25 × 4.25 inches) that can be printed on the card. The other options print images that are 2.1 × 2.8 inches. Press the SEL button to return to the Print menu.

5. If you want to print multiple copies of your card, go to the Copies menu and select the number of copies you want to print. (See page 9-9.)

6. If you want to print the time the photo was taken, go to the Time menu and select On. (See page 9-9.)

7. Go to the Color menu and select the color format you want to use for your printout. (See page 9-10.)

8. To change the print mode, go to the Mode menu and select Fast or Fine. (See page 9-10.)

9. When you’re ready to print your card, follow the steps under “Producing Your Printout” on page 9-11.
Printing Album Images

This layout allows you to print up to three images on A4 or Letter-size paper, and up to two images on A6-size cards or film. These pictures show the way your printouts appear:

This section provides an overview of how to print an album. See the steps starting on page 9-7 for detailed instructions on using most of the menus. Load your paper in the printer, then follow these steps to print album images:

1. From the Print menu, select Layout, and then select Album. (See page 9-7.)

2. Go to the Photo menu and select All to print all your photos, or select which photos you want to print. (See page 9-7.)

3. Go to the Paper menu and select the correct paper type (see page 9-8). You can select Letter, A4, or A6 for the paper size.

4. Press the ▲/▼ button to highlight Posi. (position) and press the SEL button.

You see the Position screen:

The Position setting lets you select the position on the page where the image is printed. Highlight Right, Center, Left, or Covered Binding. Covered Binding prints your images to the right and left on alternating pages so they can be bound into a book. Press the SEL button to return to the Print menu.
5 If you want to print the time each photo was taken, go to the Time menu and select On. (See page 9-9.)

6 Go to the Color menu and select the color format you want to use for your printout. (See page 9-10.)

7 To change the print mode, go to the Mode menu and select Fast or Fine. (See page 9-10.)

8 When you’re ready to print your card, follow the steps under “Producing Your Printout” on page 9-11.

**Printing Stickers**

This layout allows you to print 16 stickers (one image per page) using EPSON Photo Stickers. You may want to make a test print to make sure your pictures are aligned properly. If not, you can measure the misalignment distance (in millimeters) and use the Adjust feature in the Direct Print program. (See step 4, below.)

This picture shows the way your printouts appear:

![Photo sticker sheet]

**NOTE**

You can order EPSON Photo Stickers (product code S041144) from EPSON Accessories at (800) 873-7766.

This section provides an overview of how to print stickers. See the steps starting on page 9-7 for detailed instructions on using most of the menus. Load your photo sticker sheets in the printer, following the instructions that came with the stickers. Then follow these steps:

1 From the Print menu, select Layout, and then select Sticker. (See page 9-7.)
NOTE
Don’t use the Stickers4 layout option (available in version 2.3). This layout uses images that are a different size from your EPSON Photo Stickers.

2. Go to the Photo menu and select the photo you want to print. (See page 9-7.)

3. Go to the Color menu and select the color format you want to use for your printout. (See page 9-10.)

4. If you have made a previous printout of stickers and they are not lined up correctly, you can adjust the position of the printouts. Press the ▶/▼ button to highlight the Adjust option and press the SEL button.

The Adjust Right & Left menu appears:

Press the ◄/► or ▶/▼ button to set the adjustment and press SEL. The Adjust Top & Bottom menu appears:

Press the ◄/► or ▶/▼ button to set the adjustment and press SEL.

5. To change the print mode, go to the Mode menu and select Fast or Fine. (See page 9-10.)

6. When you’re ready to print your stickers, follow the steps under “Producing Your Printout” on page 9-11.
Printing a Contact Sheet
The index layout allows you to print a contact sheet of all or some of the images in your camera.

These pictures show the way your printouts appear:

This section provides an overview of how to print a contact sheet. See the steps starting on page 9-7 for detailed instructions on using most of the menus. Load your paper in the printer, then follow these steps to print contact sheets:

1. From the Print menu, select Layout, and then select Index. (See page 9-7.)

2. Go to the Photo menu and select All to print all your photos, or select which photos you want to print. (See page 9-7.)

3. Go to the Paper menus and select the correct paper size and type. (See page 9-8.) For the paper size, you can select Letter, A4, or A6.

4. If you want to print the date, time, and photo number for each photo, press the button to highlight the Date option and press the SEL button. The Date Print menu appears:

   Highlight On and press the SEL button.

9-16  Printing Directly From the Camera
5 Go to the Color menu and select the color format you want to use for your printout. (See page 9-10.)

6 To change the print mode, go to the Mode menu and select Fast or Fine. (See page 9-10.)

7 When you're ready to print your contact sheet, follow the steps under "Producing Your Printout" on page 9-11.

Cleaning the Print Heads
If you notice that your photos are printing too light, or if dots are missing from an image, you can run a printer cleaning cycle from the camera. This standard maintenance procedure unclogs the nozzles in the print heads.

Follow these steps:

1 From the Print menu, press the ▶/▼ button until Head cleaning is highlighted.

2 Press the SEL button to start the cleaning cycle. The LCD screen goes blank and the display panel shows a star flashing across it while the cycle runs.

Cleaning takes about two minutes, during which the printer makes some noise and the power light flashes. When it’s finished, the LCD screen displays the menu again.

3 Press the ESC button to exit the Direct Print program.
Removing Direct Print

If you installed Direct Print and aren’t using it, you can remove it to create more space for storing images. You can always upload the program later, using your PhotoPC 750Z software.

Follow these steps to remove the program:

1. Slide the camera dial lock down and turn the camera dial to Play.
2. Press the SEL button.
3. Press the << or >> button until you see the Software Menu 图标.
4. Press the SEL button.
5. Highlight Add/Delete and then press SEL.
6. Press the << button to highlight Delete and press SEL.
7. Highlight Direct Print V2.2 or Direct Print V2.3 and press SEL. The program is deleted.
8. Press the ESC button several times to return to playback mode.

Reading Error Messages

If you see a message on the LCD screen or display panel while printing, check the following tables to resolve the problem.

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery is low. Use AC adapter.</td>
<td>The camera’s battery power is almost out. Recharge or replace your batteries, or connect the AC adapter to the camera.</td>
</tr>
<tr>
<td>Check Printer Model.</td>
<td>The camera is not connected to a compatible printer. Connect the camera to one of the printers listed on page 9-1 and then press the SEL button to begin printing. (If you want to cancel printing, press the ESC button for 3 seconds.)</td>
</tr>
<tr>
<td>No photos in memory</td>
<td>This message appears when there are no photos in the camera’s memory. Press SEL to return to the Print menu.</td>
</tr>
<tr>
<td>Message</td>
<td>Explanation</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Check Printer Connection or Printer Error.</td>
<td>Printing stopped because of a printer error. Clear the error (you may need to turn the camera and printer off and then on again), then start printing again from the beginning. (See your printer’s User’s Guide for troubleshooting information.)</td>
</tr>
<tr>
<td>Printing Canceled</td>
<td>This message appears when you hold down the ESC button for more than 3 seconds while printing. The printer stops printing and ejects the paper. The Print menu reappears.</td>
</tr>
<tr>
<td>Print setting is returned to default.</td>
<td>This message appears when an error occurs while the Direct Print program is working. The settings you have made are replaced by the default settings. Press the SEL button to go back to the Print menu and enter your print settings again.</td>
</tr>
<tr>
<td>E51: Another interface is active</td>
<td>The printer is receiving a print job through another interface. When the print job ends, the printer begins printing from the Direct Print program automatically.</td>
</tr>
<tr>
<td>E55: No ink</td>
<td>Printing stopped because the printer ran out of ink. Replace the ink cartridges as needed and start printing again from the beginning. (See your printer User’s Guide for instructions.)</td>
</tr>
</tbody>
</table>
| E56: No paper or paper jam       | No paper: Load paper in the printer and then press the printer’s Load/Eject button to begin printing. (Or press the camera’s ESC button for 5 seconds to cancel printing.)  

Paper jam: Printing stopped because paper is jammed in the printer. Turn off the printer, remove the jammed paper, and then press the printer’s Load/Eject button.
Your PhotoPC 750Z camera is easy to take care of, and any problems you may have are easy to solve. This chapter includes the following sections:

- Caring for the camera and battery charger
- Solving camera problems
- Solving picture problems

Caring for the Camera and Battery Charger

Your PhotoPC 750Z requires only basic care. Before you perform any maintenance procedures, be sure to read the safety instructions in the Introduction. Then follow these guidelines:

Cleaning the Camera and Battery Charger

- Unplug the battery charger before cleaning.
- Use a clean, dry cloth to wipe the camera free of dust.
- Use a damp cloth for cleaning the battery charger.
- Keep the battery charger terminals clean by wiping them with a dry cloth.
- Don’t use harsh or abrasive cleaners. Don’t use liquid or aerosol cleaners.
- To clean the lens, first blow off any loose dust or dirt. Then breathe on the lens and wipe off all moisture with a soft, lint-free cloth or lens cleaning tissue. To avoid scratching the lens, don’t press too hard.
If necessary, clean the battery contacts with a dry cloth.
If the LCD screen gets fingerprints or smudges on it, use a soft, damp cloth to lightly wipe the screen.

Storing the Camera
Keep the lens cover on and store the camera in a carrying case or bag when you’re not using it. Push the camera dial lock up to make sure the camera stays off.
When the camera is not used for long periods of time, remove the batteries and store them at a low temperature in a dry location. This prevents camera damage from battery leaks or corrosion.
Do not store the camera in the following locations:
- Where it will be exposed to direct sunlight, for example, on a car dashboard
- Near bright sources of light or high humidity
- Near heat sources or in a closed car or trunk
- In areas of excessive dirt or dust
- Where it will be exposed to strong vibrations or magnetic fields

Solving Camera Problems
Before you call for help, check this list of problems and possible solutions:
The camera has no power.
- Make sure the camera dial is turned all the way to On or View.
- The camera may have shut off automatically. Turn the camera dial On and then Off or press the shutter button to turn the power back on.
- Check the batteries and make sure they are installed correctly. Recharge or replace the batteries.
- If you are using the AC adapter, make sure it is plugged into a working outlet.
You can’t take a picture with the camera.

- The flash may be recharging. Wait until the status light turns green, and try again.
- The camera may be full. Check the picture counter on the display panel. Erase some pictures (see Chapter 3), or transfer the pictures to your computer and then erase them (see Chapter 4). Or, install or remove your CompactFlash storage card to take more pictures (see Chapter 8).
- If you’re using a CompactFlash storage card, you may need to format or eject it. Check to see if a message is displayed on the camera’s LCD screen.
- The camera may be connected to your computer. When it’s connected, you can’t use any of the controls on the camera itself. See Chapter 6 for instructions on taking pictures from your computer.

The flash doesn’t work.

- Make sure the flash is not set to the flash off setting.
- Check the batteries and make sure they are installed correctly. Recharge or replace the batteries if necessary.
- You can’t use the flash when you adjust the shutter speed manually with the camera connected to the computer. Set the shutter speed to automatic to use the flash.

The optical zoom doesn’t work.

- If you turn on the camera with the lens cover attached, the optical zoom may not work correctly. Turn off the camera, make sure the lens cover is not attached, then turn on the camera and try taking a photo again.

Nothing appears on the LCD screen.

- Check your batteries and make sure they are installed correctly. Recharge or replace the batteries if necessary.
- The camera may have shut off automatically. Press the shutter button or turn the camera dial to Off and then back to View or Play.
- Make sure the lens cover is removed.
The icon appears on the LCD screen when you take a picture in View mode.

- The icon appears when the camera needs to be especially still, such as when taking pictures in the dark (using the slow flash feature). Make sure to hold the camera steady.
- Try turning on the flash, using a tripod, or setting the Sensitivity to Med. or High.

The image on the screen is too dark.

- Adjust the brightness of the screen using the Settings menu. See page 6-11 for instructions.

Nothing appears on the television when you connect your camera to it.

- Make sure the video cable is connected correctly, as described in Chapter 2, and the camera and TV are turned on.
- Make sure your camera is set to Play.

- Make sure the TV is set to video mode. See the manual for your television if you need help. You need to have S-Video on your TV to use this option.
- Check your batteries and make sure they are installed correctly. Recharge or replace the batteries if necessary.

The “pictures remaining” number on the display panel doesn’t decrease after you take a picture.

- Your camera is operating correctly. The total number of pictures you can store depends on your pictures’ content. So the number doesn’t always change, especially when you’re using standard image quality.

You get an error message when you try to transfer your pictures to the computer.

- Make sure the cable is connected correctly as described in Getting Started.
- Make sure your camera is turned on and the batteries have enough power.

10-4 Maintenance and Troubleshooting
Check the serial port settings in your Image Expert or EPSON Photo!2 software. You may need to change the Port and Speed serial connection settings to Auto.

If you're using a Windows system and have trouble connecting to the COM port, check the computer's COM port settings. Make sure the port is properly configured and that the Base I/O port address and the Interrupt Request Number (IRQ) assigned to the port are not in conflict with any other devices.

Check the port setting in your Windows Control panel. You may need to set your port to a faster speed, lower the FIFO buffer size (advanced serial port configuration), or adjust the speed in your software. See Chapter 6 for more information.

If you're using a Macintosh and the camera is sharing a serial port with another device, turn AppleTalk off.

Make sure you don't have both Image Expert and EPSON Photo!2 open at the same time.

You get a “Camera Connection Failed” error message when you're using your PhotoPC 750Z software with the camera connected to your computer.

Make sure the cable is connected correctly as described in Getting Started. Also make sure your camera dial is turned to View and the batteries have power.

Check the serial port settings in your Image Expert or EPSON Photo!2 software. You may need to change the Port and Speed serial connection settings to Auto.

If you were able to use the camera with the computer previously and then changed or added other settings on your system, you may have a COM port conflict. Try using a different COM port or reconfiguring the COM port settings. (See your Windows documentation for instructions.) If you were not able to use the camera with your computer previously, you may have an inoperable serial cable. Try using another cable.

Avoid opening or working with other software applications while the camera and computer are communicating.
You are unable to drag and drop photos into a document.

- If you’re using Windows NT 3.51, this method of getting pictures into your documents may not be reliable. Try importing or using copy and paste.
- If your system has less than 16MB RAM, you may not be able to use drag and drop. Make sure you don’t run too many applications at the same time. You may need to add memory to your system or use another method of getting photos into your documents.
- Your application may not support this method of adding pictures.

You are unable to copy and paste or import your photo into a document on your Macintosh.

- Try increasing your virtual memory using the Memory Control Panel. Also increase the memory allocation for your word processor or other application. (Select the application and choose Get Info from the File menu.)
- Try turning off any unnecessary extensions. See your Macintosh documentation for more information.

The pictures transfer to your computer too slowly.

- If your system has less than 16MB RAM, the transfer speed may be slow. Try using virtual memory. See your computer documentation or system help for more information.
- Check the port setting in your Windows Control panel. You may need to set your port to a faster speed. See your Windows documentation or help system for more information.
- If you’re transferring pictures to an application through the TWAIN interface or EPSON Photo!2 and you use the PhotoEnhance feature, the transfer will take longer. Try transferring without PhotoEnhance.

You get an error message when you use the Image Expert Save to Floppy feature.

- Make sure the diskette you’re using is not write-protected.
You get a TWAIN error message when you try to transfer images with Adobe® Photoshop.

- If you’re using Windows NT 3.51, make sure you select TWAIN (not TWAIN_32) as your source.
- If you’re using Windows NT 4.0, you may need to upgrade your software to Photoshop 4.0, or later. Earlier versions of Photoshop do not support Windows NT 4.0.
- If you’re using Windows 95 or Windows 98, make sure you select TWAIN_32, not TWAIN.

You are unable to format or use a CompactFlash storage card with your camera.

- Make sure you’re using an ATA-compatible CompactFlash card. Other cards may not work with PhotoPC 750Z. If you need help with a card, call the appropriate number:
  - Lexar Media, (800) 789-9418
  - SanDisk, (408) 542-0595
  - Simple Technology,® (800) 4-SIMPLE

Your notebook computer’s PCMCIA drive can’t access a CompactFlash storage card with a PCMCIA adapter.

- If you’re using an IBM Thinkpad,™ call IBM for technical support or follow these steps to download and install an updated driver from IBM:
  2. Make sure your PC Card driver says “PCIC or compatible PCMCIA controller on IBM System” in the Control Panel/System/Device Manager. Then select Update Driver/Have Disk and refer the system to A: for all missing files. (If your PC Card driver says “PCIC or compatible PCMCIA controller,” go to Control Panel/System/Device Manager/Update Driver, and select “PCIC or compatible PCMCIA controller on IBM System.”)
3 Insert the CompactFlash card with a PCMCIA adapter. The system should prompt for a driver. Select OK to use the Windows default “ESDI/IDE HDD Controller” driver. A folder appears on the desktop with a drive letter that has been assigned to the card.

When you upload pictures to a storage card in your computer, your system appears to hang.

- Check the status bar at the bottom of your screen. If it shows that the transfer is complete, your system is operating correctly. You may have to click your mouse to change the hourglass icon to a normal pointer.

When you copy image files from your computer to a storage card in your PCMCIA drive, the camera can’t access the images.

- You can’t use this method to upload pictures to the camera. You have to use the EPSON Photo File Uploader to convert and upload your images.

Solving Picture Problems

If you’re not satisfied with some of the pictures you get from the PhotoPC 750Z, you may need to adjust some of the camera settings. Read the suggestions below.

Your pictures display poor image quality on the screen or when you print them out.

- PhotoPC 750Z captures images in 24-bit color (16.7 million colors). Your pictures will not display maximum image quality if your monitor or computer’s video controller doesn’t support this color depth. You may need to upgrade your system to achieve the best possible image quality.

- If your pictures look better on the screen than when you print them out, you may need to upgrade your printer. An EPSON Stylus ink jet printer, for example, provides excellent image quality.

- If you used drag and drop to insert your pictures, they may appear grainy. Try importing them into your documents instead.
When you preview images on your computer, they look distorted.

- If you are using an STB® Velocity 128 video card and have a screen resolution of 800 × 600 or 640 × 480, you may notice this phenomenon. Slowing down the acceleration on your video card may solve this problem: Click Start, point to Settings, click Control Panel, then double-click System Properties. On the Performance tab, click the Graphics button. Select a slower acceleration and click OK. See your Microsoft Windows documentation or online Help for more information.

The colors in your picture don’t look right.

- When you take pictures under certain artificial lighting conditions, the colors may be slightly distorted. You can use your Image Expert software to adjust the colors, as described on page 5-3.

Your picture is blurry or out of focus.

- Make sure your subject is within the camera’s range. You should be at least 31 inches away to take a picture without the flash, and 31 inches to 8 feet away to take a picture with the flash. You can take a picture as close as 8 inches in macro mode.

- When you take macro close-ups, make sure you have adequate lighting (with the flash disabled). Using a tripod will help you capture sharp pictures.

- Make sure you hold the camera steady after you press the shutter button (until the red light starts to flash), and your subject isn’t moving. If you are shaking the camera when you lock the focus, a warning icon appears in the right corner of the LCD.

- If you want to photograph a moving subject, you can change the shutter speed while the camera is connected to your computer. Try increasing the shutter speed. For more information, see Chapter 6.

- Make sure your flash is not set to flash off.
When you focus on a nearby object, your picture’s background may appear blurry. Try changing your focus.

Your picture is too dark (underexposed).
- You may need to use the flash. Make sure the setting is not flash off.
- If you’re using the flash, make sure your subject is within the range of 8 feet.
- Use Image Expert to adjust the picture’s brightness and contrast as described on page 5-3.
- Try using the camera’s manual exposure control or sensitivity control.
- If you’re using the macro mode to take a close-up photo, be sure to provide adequate lighting for your subject, since the camera’s smallest aperture setting (F8) is automatically selected in this mode.

If you’re taking a picture at night and you want to light up the background as well as your subject, use the camera’s slow synchronized flash mode as described on page 1-17.

Your picture is too light (overexposed).
- If you’re using the forced flash setting, it may be too bright. Try setting the flash to Auto.
- If you’re facing a bright light source, you may need to shoot your picture from a different angle.
- Use Image Expert to adjust the picture’s brightness as described on page 5-3.
- Try using the camera’s manual exposure control.

Part of your picture is missing.
- Make sure you’re not blocking the lens with your finger, wrist strap, clothing, or other object.
A horizontal or vertical red line appears on your picture.

- Red lines are caused by glare. Avoid photographing shiny surfaces that reflect excessive amounts of light into your lens.

The wrong date and/or time are displayed on your pictures.

- Whenever you change the batteries in your camera you need to reset the clock. You can use the LCD screen Settings menu or set the camera’s clock from your computer. See *Getting Started* and Chapter 6 for more information.

Your pictures don’t look as good as they used to.

- Your camera’s lens may be dirty or dusty. Try cleaning it by following the instructions on page 10-1.

The area captured in the photo is different from what you saw in the viewfinder.

- Make sure you look straight through the viewfinder. Keep in mind that the area visible through the viewfinder is slightly smaller than the area captured in the photo.
- If you’re taking a close-up or macro mode picture, use the LCD screen.
Optional Accessories

You can use the PhotoPC 750Z with a variety of options. To save battery power, you can use the AC adapter. For portraits or other studio photographs, you can attach a tripod to your camera. You can also get a second set of NiMH batteries or a replacement NiMH Power Pak.

To increase your camera’s picture storage capacity and add flexibility, you can use CompactFlash memory cards and PCMCIA adapters. You can also use an IOMEGA Clik! drive to store photos and transfer them to your computer.

EPSON recommends CompactFlash memory cards from the following manufacturers:

- Lexar Media, (800) 789-9418
- SanDisk, (408) 542-0595

For information on using memory cards, see Chapter 8.

This chapter includes the following information:

- Using the AC adapter
- Using the camera with a tripod
- About the IOMEGA Clik! drive

The AC adapter should be available where you bought your PhotoPC 750Z. You can also order it from EPSON Accessories at (800) 873-7766 (U.S.) or (800) 873-7766 (Canada-dealer referral).

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Product code</th>
</tr>
</thead>
<tbody>
<tr>
<td>PhotoPC 750Z AC Adapter</td>
<td>B867038</td>
</tr>
<tr>
<td>NiMH Battery Pak (4 batteries)</td>
<td>B818061</td>
</tr>
<tr>
<td>NiMH Power Pak (charger and 4 batteries)</td>
<td>B818051</td>
</tr>
</tbody>
</table>

Optional Accessories A-1
Using the Optional AC Adapter
The AC adapter (B867038) allows you to connect your PhotoPC 750Z to any standard (110 V) electrical outlet. This is especially useful for transferring pictures and operating the camera from your computer, or using Direct Print. The adapter powers the camera but does not charge the batteries.

WARNING
- Use only the adapter designed for the PhotoPC 750Z. Using any other adapter may cause fire, electrical shock, or injury.
- Do not alter the plug on the power cable, and do not use the adapter for any other purpose than powering your PhotoPC 750Z.

To avoid losing any images or settings, make sure the camera is finished processing. Turn the camera off before you connect or disconnect the AC adapter. Then follow these steps:

1. Open the connector cover on the side of the camera.

2. Plug the adapter cable into the DC port on the camera.

3. Plug the AC adapter into an electrical outlet.

Using an Optional Tripod
You can use your PhotoPC 750Z with any standard tripod. Follow these steps:

1. Assemble and set up the tripod by following the manufacturer’s instructions. Make sure the tripod is well-balanced on a flat surface.
2 Find the opening for the tripod screw on the bottom of your camera. Carefully place the camera on the tripod. Screw the camera on until it is firmly in place.

3 Adjust the tripod to view your subject as desired.

**About the IOMEGA Clik! Drive**

You can use an IOMEGA Clik! digital camera drive to store extra pictures when you’re on the go and read CompactFlash cards directly from your computer. This drive saves time and batteries because you don’t have to download pictures from your camera to your computer. You should be able to find the IOMEGA Clik! drive where you purchased your camera. For additional information, visit the IOMEGA website at: www.iomega.com. You can call IOMEGA at 1 (800) my-stuff (1 (800) 697-8833) for ordering information.
Specifications

Camera

Physical Dimensions
Width 5.41 in (137.5 mm)
Height 3.01 in (76.4 mm)
Depth 2.43 in (61.8 mm)
Weight 10.9 oz (310 g) without batteries and strap

Safety Specifications

Power
Sources
Includes 4 AA rechargeable NiMH batteries and pocket-size charger. Also accepts 4 AA batteries (single-use alkaline or lithium or rechargeable NiCad)

Optional AC adapter (B867038)

Battery Life
Approximately 1000 pictures can be taken before the standard NiMH batteries need recharging (without the LCD screen or flash)
## Technical

<table>
<thead>
<tr>
<th>Product type</th>
<th>1.25 megapixel CCD (charged coupled device) still frame auto focus camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image size</td>
<td>1280 × 960 pixels (fine and super fine)</td>
</tr>
<tr>
<td></td>
<td>640 × 480 pixels (standard)</td>
</tr>
<tr>
<td></td>
<td>1280 × 480 pixels (panoramic fine and super fine)</td>
</tr>
<tr>
<td></td>
<td>1600 × 1200 pixels* (HyPict)</td>
</tr>
<tr>
<td></td>
<td>1600 × 600 pixels* (HyPict panorama)</td>
</tr>
<tr>
<td></td>
<td>* Interpolated</td>
</tr>
<tr>
<td>File format</td>
<td>JPEG (JFIF)</td>
</tr>
<tr>
<td>Bit depth</td>
<td>16 million colors, 24-bit</td>
</tr>
<tr>
<td>Lens</td>
<td>7 elements in 7-group construction</td>
</tr>
<tr>
<td>Zoom</td>
<td>3× optical zoom</td>
</tr>
<tr>
<td></td>
<td>(equivalent to a 34 mm to 102 mm optical zoom lens on a 35 mm camera)</td>
</tr>
<tr>
<td>CCD</td>
<td>1/2.7 inch color area CCD (1,300,000 pixels)</td>
</tr>
<tr>
<td>Serial interface</td>
<td>8-pin mini-DIN (to camera), RS-232C-compatible (to computer)</td>
</tr>
</tbody>
</table>

## Environmental

| Temperature           | Operating: 41 to 95°F (5 to 35°C)                                      |
|                       | Non-operating: –4 to 140°F (–20 to 60°C)                              |
| Humidity              | Operating: 30 to 80% (non-condensing)                                 |
|                       | Non-operating: 10 to 80% (non-condensing)                             |

## Specifications

Serial communication speed: Up to 230.4 Kbps with high-speed serial port (19.2 Kbps or higher), 1.8 Mbps when connected to EPSON printers

Video out: NTSC standard

Internal memory: 4MB flash memory

Expansion memory: 8MB CompactFlash storage card
Also accepts optional 4MB to 64MB storage cards (available from Lexar Media and SanDisk)
**Photographic**

- **Lens**: f = 5.2 to 15.6 mm (equivalent to a 34 to 102 mm lens on a 35 mm camera)
  - f2.8 - 4.7
- **Range**: 31.5 inches (80 cm) to infinity
  - 8 inches to 31.5 inches (20 cm to 80 cm) (macro mode)
- **LCD screen**: 2-inch active matrix TFT color LCD (11 million pixels)
  - Lit by fluorescent light or sunlight
- **Sensitivity**: Equivalent to ISO 90/180/360
- **Exposure control**: Program auto exposure
  - Manual adjustment (–2 to +2 EV, in half-steps)
- **White balance**: TTL automatic white balance
  - Fixed white balance (5200 degrees Kelvin)
  - User-defined white balance

- **Shutter**: Electric iris with mechanical shutter,
  - 1/2 second to 1/750 second (flash off mode)
- **Viewfinder**: Real-image optical, with centering crosshair and edge border (view range over 80%)
- **Focus**: Automatic focus from 31.5 inches (80 cm) to infinity (8 inches to 31.5 inches [20 to 80 cm] macro mode)
- **Aperture**: f2.8, f8
- **Flash**: Automatic luminance control flash mode
- **Flash modes**: Forced flash, automatic, flash off, slow synchronized flash mode (can be enabled through the LCD menus)
Flash range:

<table>
<thead>
<tr>
<th>Sensitivity setting</th>
<th>Normal distance</th>
<th>3x zoom</th>
</tr>
</thead>
<tbody>
<tr>
<td>Std. (ISO 90)</td>
<td>31.5 in to 9.2 ft (0.8 to 2.8 m)</td>
<td>31.5 in to 5.2 ft (0.8 to 1.6 m)</td>
</tr>
<tr>
<td>Med. (ISO 180)</td>
<td>31.5 in to 12.8 ft (0.8 to 3.9 m)</td>
<td>31.5 in to 7.2 ft (0.8 to 2.2 m)</td>
</tr>
<tr>
<td>High (ISO 360)</td>
<td>31.5 in to 18.4 ft (0.8 to 5.6 m)</td>
<td>31.5 in to 10.5 ft (0.8 to 3.2 m)</td>
</tr>
</tbody>
</table>

Camera Picture Capacity

<table>
<thead>
<tr>
<th>Image Mode</th>
<th>Internal Memory*</th>
<th>8MB Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>50</td>
<td>128</td>
</tr>
<tr>
<td>Fine/Monochrome Fine</td>
<td>15</td>
<td>39</td>
</tr>
<tr>
<td>SuperFine/Monochrome SuperFine</td>
<td>7</td>
<td>19</td>
</tr>
<tr>
<td>HyPict/Monochrome HyPict</td>
<td>4</td>
<td>12</td>
</tr>
</tbody>
</table>

*Without Direct Print software installed.

NiMH Battery Charger

Physical Dimensions

- Width: 3.0 inches (76 mm)
- Height: 4.25 inches (108 mm)
- Depth: 0.87 inches (22 mm)
- Weight: Approximately 3.9 oz (110 g)

Technical

- Input: 120V AC, 60 Hz
- Output: DC 1.2V/650mA × 4
- Charging time: Approximately 160 minutes
- Power consumption: Approximately 8W
- Charging temperature: 32 to 95°F (0 to 35°C)
Optional AC Adapter

Physical Dimensions
Width 1.97 inches (50 mm)
Height 1.18 inches (30 mm)
1.85 inches (47 mm) including pins
Depth 3.74 inches (95 mm)

Technical
Output DC 7V/2.0A
Input 110 to 120 V AC, 50 to 60 Hz
Index

A
AC adapter, 3, A-1 to A-2, B-5
Accessories, 3, A-1 to A-2
Acquiring photos, TWAIN programs, 3-1 to 3-3
Adjusting camera settings, 6-6 to 6-12
Advanced settings, 1-11 to 1-17
Albums
   copying to diskette, 4-16 to 4-17
   displaying as slide show, 4-14 to 4-15
   dragging pictures from, 3-8 to 3-10
   making screen saver, 4-15
   organizing pictures, 4-2 to 4-3
   printing, 4-4 to 4-9
   renaming pictures, 4-3
   using, 4-2
Alert beep, setting, 6-11
Audio buttons, 4-11
Automatic shut-off, 6-2, 6-7, 6-9, 6-12

B
Batteries
   specifications, B-1
Beep, setting, 6-11
Bitmap (BMP) files, 3-4
Brightness
   correcting images, 5-3 to 5-4
   setting LCD, 6-11
C
Cable
   direct print, 9-4
   video, 2-12, 7-10
Camera, see PhotoPC 750Z camera
Camio Viewer, 3-10 to 3-12
Caring for camera, 10-1 to 10-2
Cleaning camera, 10-1 to 10-2
Clock, setting, 6-10
Close-up pictures, 1-2
Color correcting, 5-3 to 5-4
Color depth, 5-12
CompactFlash memory cards
  capacity, 8-2
  copying images, 8-7 to 8-8
  formatting, 8-3 to 8-4
  information, 8-6
  installing, 8-2
  problems, 10-7
  removing, 8-4
  transferring images, 8-4 to 8-6
  uploading images to, 7-1 to 7-7
CompuServe, 5
Conditions menu, 1-6, 1-7, 1-9, 1-10
Continuous shooting, 1-7 to 1-9
Contrast, correcting, 5-3 to 5-4
Copying pictures
  into documents, 3-8
  to and from storage cards, 8-7 to 8-8
  to diskette, 4-16 to 4-17
Cropping images, 5-5

D
Date, setting, 6-10
Deleting pictures, see Erasing pictures
Deleting sounds, 4-11 to 4-12

Digital panorama, 1-3 to 1-5
Digital zoom, 1-5
Direct Print program
  error messages, 9-18 to 9-19
  removing, 9-18
  uploading, 9-2 to 9-3
  using, 9-1 to 9-3
Diskettes, copying pictures, 4-16 to 4-17
Distorting images, 5-7 to 5-8
Documents, getting pictures into, 3-6 to 3-12
Downloading pictures, 3-10 to 3-12
Drag and drop, 3-8 to 3-10, 3-12

E
Edges, sharpening, 5-8
Editing
  images, 5-2 to 5-12
  sounds, 4-11
Environmental specifications, B-2
EPSON
  Electronic support services, 5
  help, 4 to 5
  registration, 6
  World Wide Web site, 5
EPSON Photo File Uploader, 7-1 to 7-10
EPSON Photo!2
   support, 6
   using, 3-3 to 3-6
Equalization, 5-4
Erasing pictures from camera
   using computer, 3-3, 3-4, 3-11
   using LCD screen, 2-7 to 2-9
Erasing sounds, 4-11 to 4-12
Error messages
   on camera, 9-18 to 9-19
   on computer, 3-5, 10-4, 10-6
Exporting images, 3-3 to 3-4
Exposure, adjusting, 1-14 to 1-16
F
FaxAdvice service, 5
Files
   BMP, 3-4
   converting during transfer, 3-3 to 3-4
   JPEG, 3-3 to 3-4, 3-6
   PCX, 3-4
   PICT, 3-4
   resizing, 5-5 to 5-6
   uploading, 7-1 to 7-7
   viewing information, 4-3 to 4-4
Fisheye effect, 5-8
Fixed white balance, 1-11
Flipping images, 5-7
FTP, 5
G
Glass blocks effect, 5-8
H
Help, EPSON, 4 to 5
HyPict mode, 1-10 to 1-11
I
Image Expert
   albums, 3-8 to 3-10, 4-2 to 4-17
   camera settings, changing, 6-6 to 6-7
   Camio Viewer, 3-10 to 3-12
   color correcting, 5-3 to 5-4
   color depth, changing, 5-12
   copying pictures to diskette, 4-16 to 4-17
   correcting images, 5-3 to 5-4
   cropping, 5-5
   editing pictures, 5-2 to 5-12
   e-mailing pictures, 4-18 to 4-19
   flipping images, 5-7
   picture information, 4-3 to 4-4
   printing, 4-4 to 4-9
Index

Image Expert (continued)
- resizing images, 5-5 to 5-6
- resolution, changing, 5-5 to 5-6
- rotating, 5-6
- screen saver, 4-15
- selection tools, 5-2
- shutter speed, setting, 6-4
- slide shows, 4-14 to 4-15
- sound, adding, 4-9 to 4-12
- special effects, 5-7 to 5-8
- taking pictures from computer, 6-1 to 6-3
- transferring pictures, 3-10 to 3-12
- wallpaper, 4-15
- zoom tool, 5-2

Images, see Pictures

Importing photos, TWAIN programs, 3-1 to 3-3

Information menu, 1-6, 2-3

Internet, 5

Inverting images, 5-7 to 5-8

J

JPEG files, 3-3 to 3-4, 3-6

L

Language menu, 2-3

Language, setting, 6-12

LCD screen
- copying to and from storage card, 8-7 to 8-8
- customizing settings, 6-9 to 6-12
- displaying memory information, 8-6
- erasing pictures, 2-7 to 2-9
- formatting storage card, 8-3 to 8-4
- locking and unlocking pictures, 2-9 to 2-12
- magnifying pictures, 2-6
- menus, 1-6, 2-3
- problems, 10-3
- setting alert beep, 6-11
- setting brightness, 6-11
- setting date and time, 6-10

Lexar Media, 8-1, 8-4

Licensing software, 6

Live preview, 6-1 to 6-5

Locking and unlocking pictures, 2-9 to 2-12

M

Macintosh
- capturing screens, 7-9
- uploading pictures, 7-5 to 7-9

Magnifying pictures, 2-6

Maintenance, 10-1 to 10-2

Memory capacity, 8-2

Memory information, 8-6
N
Negative images, 5-8
Night photography, 1-16 to 1-18

P
Panorama/zoom menu, 1-3 to 1-5
Panoramas, stitching, 5-8 to 5-12
Panoramic pictures (digital), 1-3 to 1-5
PCMCIA adapter, 8-1, 8-4 to 8-6
PCX files, 3-4
Photo Control menu, 2-3, 2-8 to 2-12, 8-3
Photo File Uploader, 7-1 to 7-11
Photographic specifications, B-3

PhotoPC 750Z camera
AC adapter, using with, A-2
auto shutoff, 6-2, 6-7, 6-9
cleaning, 10-1 to 10-2
date, setting, 6-10
features, 2 to 3
language, setting, 6-12
maintaining, 10-1 to 10-2
problems, solving, 10-2 to 10-11
settings, adjusting, 6-6 to 6-12
software, 3
 specifications, B-1 to B-5
storing, 10-2
time, setting, 6-7, 6-10
timer, 1-2
tripod, attatching to, A-2
Photos, see Pictures
Physical dimensions, B-1
PICT files, 3-4
Pictures
- capturing from computer, 6-1 to 6-5
close-up, 1-2
color correcting, 5-3 to 5-4
color depth, changing, 5-12
continuous, 1-7 to 1-9
converting, 3-6
copying to diskette, 4-16 to 4-17
correcting, 5-2 to 5-4
cropping, 5-5
digital panorama, 1-3 to 1-5
digital zoom, 1-5
downloading, 3-10 to 3-12
editing, 5-2 to 5-12
e-mailing, 4-18 to 4-19
erasing with camera, 2-7 to 2-9
erasing with computer, 3-3, 3-4, 3-11
exporting, 3-3 to 3-4
flipping, 5-7
information, 2-5 to 2-6
inserting in documents, 3-6 to 3-12
inverting, 5-7 to 5-8
locking and unlocking, 2-9 to 2-12
magnifying, 2-6
organizing in albums, 4-2 to 4-3
panorama, 1-3 to 1-5
playing back on LCD screen, 2-1 to 2-12
playing back on TV, 2-12
printing from camera, 9-1 to 9-3
printing from computer, 4-4 to 4-9
problems, solving, 10-8 to 10-11
resizing, 5-5 to 5-6
rotating, 5-6
screen saver, 4-15
selecting sections, 5-2 to 5-4
slide shows, 2-5, 4-14 to 4-15
special effects, 5-7 to 5-8
storage capacity of camera, 8-2, 8-6
transferring from camera, 3-10 to 3-12
transferring from PCMCIA adapter, 8-4 to 8-6
uploading, 7-1 to 7-7
viewing information, 2-5 to 2-6, 4-3 to 4-4
wallpaper, 4-15
zoom, 1-5
Playback Mode menu, 2-3
Playing back pictures, 2-1 to 2-14
Power
- AC adapter, A-1 to A-2, B-5
camera specifications, B-1
mode, setting, 6-12
problems, 10-2
Presentations, using camera for, 7-1 to 7-11
Printing directly from camera
album, 9-13 to 9-14
cards, 9-11 to 9-12
contact sheets, 9-16 to 9-17
full-size photos, 9-6 to 9-10
selecting paper, 9-2, 9-8 to 9-9
stickers, 9-14 to 9-15

Printing photos from computer
adding text, 4-7
adjusting printed area, 4-8
choosing album images, 4-8
layout styles, 4-5 to 4-6

Problems
camera, 10-2 to 10-7
picture, 10-8 to 10-11

Projector, playing back pictures and presentations, 7-10

Q
Quick Fix, 5-3
Quick Shots, 1-9 to 1-10

R
RAM, system requirements, 4
Registration, 6
Resizing files, 5-5 to 5-6
Resolution, 5-5 to 5-6

Ripples effect, 5-8
Rotating pictures, 5-6

S
Safety instructions, 6 to 8
Safety specifications, B-1
SanDisk, 8-1, 8-4
Save to Floppy option, 4-17
Screen captures, 7-8 to 7-10
Self timer, 1-2, 6-3 to 6-5
Sensitivity, adjusting, 1-16 to 1-17
Settings menu, 2-2, 6-9 to 6-12
Sharpness, adjusting, 5-4
Shut-off, automatic, 6-7, 6-9
Slide Show menu, 2-3
Slide shows, 2-5, 4-14 to 4-15
Software
  licensing, 6
  support, 6
Software Menu, 2-3
Sound
  adding, 4-9 to 4-12
deleting, 4-11 to 4-12
  editing, 4-11
  playing back, 4-10 to 4-11
  recording, 4-9 to 4-10
Index

SoundAdvice, 5
Special effects, 5-7 to 5-8
Specifications, B-1 to B-5
Stitching panoramas, 5-8 to 5-12
Storage cards, see CompactFlash memory cards
Storing camera, 10-2
Support
   EPSON, 4 to 6
   software, 6
System requirements, 4

T
Taking pictures
   close-up, 1-2
   continuous, 1-7 to 1-9
   digital panorama, 1-3 to 1-5
   digital zoom, 1-5
   with the timer, 1-2
Technical support, 4 to 6
Time, setting, 6-7, 6-10
Timer, 1-2, 6-3 to 6-5
Tripod, A-2
Troubleshooting, 10-2 to 10-11
TWAIN programs, acquiring photos, 3-1 to 3-3

U
Unlocking pictures, 2-11 to 2-12
Uploading
   Direct Print program, 9-2 to 9-3
   pictures, 7-1 to 7-7

V
VCR, playing back pictures, 2-12
Video cable, 2-13, 7-11
Videotaping pictures, 2-12

W
White balance, 1-11 to 1-14
Windows
   capturing screens, 7-8 to 7-9
   system requirements, 4
   uploading pictures, 7-2 to 7-5
World Wide Web, 5

Z
Zoom pictures (digital), 1-5
Zoom tool, 5-2
EPSON AMERICA, INC.
LIMITED WARRANTY

What is Covered: Epson America, Inc. ("EPSON") warrants to the first end-user customer that the EPSON PhotoPC 750Z Digital Camera enclosed with this limited warranty statement, if purchased and used in the United States or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship and materials for a period of one year from the date of original purchase. EPSON further warrants to the first end-user customer that the Nickel Metal Hydride Battery Charger and four Nickel Metal Hydride Batteries enclosed with this limited warranty statement will be free from defects in workmanship and materials for a period of ninety days from the date of original purchase.

What EPSON Will Do To Correct Problems: Should your EPSON product prove defective during the warranty period, please call EPSON at 310-782-2600 for warranty repair instructions and return authorization, if required. An EPSON service technician will provide telephone diagnostic service to determine whether the unit requires repair. If repair is required, EPSON will, at its option, repair or replace on an exchange basis the defective unit, without charge for parts or labor. If the product requires repair or replacement, it is your responsibility to package it in its original container or an equivalent, along with proof of the date of original purchase and ship it to EPSON. Packaging and shipping costs incurred in presenting your EPSON product for warranty service are your responsibility. Return shipping costs from the EPSON repair facility are EPSON’s responsibility. When warranty service involves the exchange of the product or of a part, the item replaced becomes EPSON property. The exchanged product or part may be new or previously repaired to the EPSON standard of quality. Exchange or replacement products or parts assume the remaining warranty period of the product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal consumer use in the United States and Canada. This warranty does not cover damage to the EPSON product caused by parts or supplies not manufactured, distributed or certified by EPSON. This warranty does not cover third party parts, components or peripheral devices added to the EPSON product after its shipment from EPSON. EPSON is not responsible for warranty service should the EPSON label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-EPSON products, or service other than by an EPSON Authorized Servicer. If a claimed defect cannot be identified or reproduced in service, you will be held responsible for costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE.

UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions. Some jurisdictions do not allow limitations on how long an implied warranty lasts and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you.

This warranty gives you specific legal rights, and you may also have other rights which vary from jurisdiction to jurisdiction.

To locate the EPSON Authorized Reseller nearest you call:
(800) 442-2110
or write to:
Epson America, Inc. • P. O. Box 2842 • Torrance, CA 90509-2842 • MS: CS1